CLINIVIEW™ 11.4

Installation Manual

A4 212521 rev. 4

A5 212523 rev. 4
Copyright

Code: 213239 rev 4
Copyright © 2017 by Instrumentarium Dental, PaloDEx Group Oy. All rights reserved.

CLINIVIEW™, SCANORA™, EXPRESS™, SNAPSHOT™, CRANEX™ and DIGORA™ are either registered trademarks or trademarks of PaloDEx Group Oy.

KaVo™, Scan eXam™ and Pan eXam™ are either registered trademarks or trademarks of Kaltenbach & Voigt GmbH.

All other trademarks are property of their respective owners.

Documentation, trademark and the software are copyrighted with all rights reserved. Under the copyright laws the documentation may not be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine readable form in whole or part, without the prior written permission of Instrumentarium Dental, PaloDEx Group Oy.

The original language of this manual is English.

Instrumentarium Dental, PaloDEx Group Oy reserves the right to make changes in specification and features shown herein, or discontinue the product described at any time without notice or obligation. Contact your Instrumentarium Dental, PaloDEx Group Oy representative for the most current information.

Manufacturer

Instrumentarium Dental, PaloDEx Group Oy
Nahkelantie 160
Fl-04300 Tuusula
FINLAND

Tel. +358 10 270 2000
www.kavo.com

For service, contact your local distributor.
# Table of Contents

1 Introduction .................................................................................................................. 1  
1.1 General ................................................................................................................. 1  
1.2 Manufacturer’s liability......................................................................................... 2  
1.3 Abbreviations ....................................................................................................... 2  
1.4 System requirements .......................................................................................... 3  
  1.4.1 Minimum system requirements for the software client.............................. 3  
  1.4.2 Minimum system requirements for DTX Studio Core (database)........... 4  
1.5 The software specifications................................................................................... 5  
1.6 The software DICOM SOP Classes ..................................................................... 8  
1.7 The software compatibility table........................................................................ 10  
2 Software installation.................................................................................................. 11  
2.1 Standalone .......................................................................................................... 15  
2.2 Small network..................................................................................................... 21  
  2.2.1 Small network server............................................................................... 21  
  2.2.2 Small network viewing workstation ...................................................... 28  
2.3 Network system.................................................................................................... 33  
  2.3.1 DTX Studio Core installation................................................................. 33  
  2.3.2 Network modality workstation .............................................................. 39  
  2.3.3 Standalone License Server.................................................................... 44  
3 Licensing CLINIVIEW™ software............................................................................. 45  
3.1 Important licensing information ........................................................................... 45  
3.2 Licensing CLINIVIEW standalone ..................................................................... 46  
  3.2.1 Online connection .................................................................................... 46  
  3.2.2 Offline connection .................................................................................... 49  
  3.2.3 Trial period activation ............................................................................. 54  
3.2.4 Licensing CLINIVIEW network ................................................................. 54  
  3.2.4.1 Activating CLINIVIEW network license......................................... 54  
  3.2.4.2 Configuring workstations to use CLINIVIEW network license ... 55  
3.2.5 License Manager........................................................................................... 57  
4 Driver installation ...................................................................................................... 61  
4.1 Device drivers ..................................................................................................... 61  
4.2 NVIDIA drivers .................................................................................................... 61  
4.3 PCI driver installation .......................................................................................... 61  
  4.3.1 PCI driver update ..................................................................................... 65  
  4.3.2 Uninstalling the PCI driver........................................................................ 69  
4.4 Intraoral camera installation ................................................................................ 70  
  4.4.1 Video Format dialogs ............................................................................... 72  
  4.4.2 Video Source dialog ............................................................................... 73  
  4.4.3 Video Input dialog .................................................................................... 73  
  4.4.4 Link the software to Intra camera event ................................................... 74  
4.5 KaVo DIAGNOcam ............................................................................................. 75
1 Introduction

1.1 General

The CLINIVIEW™ software (hereafter called “the software”) is a complete solution for digital image acquisition, processing, viewing and storing. The software supports many different models of intraoral sensors and scanners, extraoral X-ray units and intraoral video cameras. Refer to 1.7 The software compatibility table for a list of supported devices. Images can also be imported from other digital sources. The software stores images and patient information in a database.

This manual covers the installation of the software Standard and DICOM versions. The user manual describes how to use the software. See the equipment manuals before installing or using the equipment. See the Windows manuals for further information about the Windows environment.

With the software you can perform the following operations:

- Create a new patient and store patient information in a database.
- Capture and store digital X-ray images with exposure values from the device.
- Capture and store intraoral photographs.
- Export and import digital images.
- Process images to enhance their diagnostic value with dental specific tools.
- Analyse the image with application specific measurement tools.
- Build an environment with multiple workstations using a database shared over a network.
- Printing images and image information.
- Capture 3D images and Launch 3rd party image analysis and planning tools.

The software lets you import and export image files in many common file formats.

The software can be used in a network environment. If the software is installed in several computers, the patient and image database can be shared and used from different workstations.

We recommend to read this manual before installing and using the software.
CAUTION! USA only: Federal law restricts this device to sale by or on the order of a dentist or other qualified professional.

1.2 Manufacturer’s liability

As a manufacturer, we can only assume liability for safe and reliable operation of this software when the PC software is installed and used according to the software installation and user manuals.

Safe and reliable usage of the product requires that the user has read and understood the instructions and restrictions given in the manual.

1.3 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC</td>
<td>Personal computer</td>
</tr>
<tr>
<td>HD</td>
<td>Hard disk</td>
</tr>
<tr>
<td>Hz</td>
<td>Hertz; cycles per second</td>
</tr>
<tr>
<td>MHz</td>
<td>Megahertz, millions of cycles per second</td>
</tr>
<tr>
<td>CPU</td>
<td>Central processing unit (computer)</td>
</tr>
<tr>
<td>RAM</td>
<td>Random access memory</td>
</tr>
<tr>
<td>MB</td>
<td>Megabytes</td>
</tr>
<tr>
<td>GB</td>
<td>Gigabytes</td>
</tr>
<tr>
<td>CCD</td>
<td>Charge-coupled device</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>Digital Versatile Disc (re-writable)</td>
</tr>
<tr>
<td>PCI</td>
<td>Peripheral Component Interconnect</td>
</tr>
<tr>
<td>DAT</td>
<td>Digital audio tape</td>
</tr>
<tr>
<td>MOD</td>
<td>Magneto optical drive</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VfW</td>
<td>Video for Windows, a video format supported by the software Intraoral Camera interface.</td>
</tr>
<tr>
<td>WDM</td>
<td>Windows Driver Model, a video format supported by the software Intraoral Camera interface.</td>
</tr>
</tbody>
</table>
1.4 System requirements

The requirements listed below are the minimum requirements to install and use the software for basic 2D imaging. When using the software together with an imaging device, please refer to the unit installation manual for additional requirements. 3D units specifically have additional computer requirements not listed below.

1.4.1 Minimum system requirements for the software client

| Operating System (OS)       | - Windows 7 Professional/ Ultimate/Enterprise SP1 |
|                            | - Windows 8.1 Pro/Enterprise                        |
|                            | - Windows 10 Pro/Enterprise                         |
| Memory (RAM)               | At least 4 GB                                       |
| Processor                  | Intel Core i3, or better                            |
| Hard disk                  | 8 GB free space                                     |
| DVD-ROM                    | DVD-ROM for installation                            |
| Keyboard                   | Yes                                                 |
| Mouse                      | Yes                                                 |
| Network adapter            | 100/1000 Mb/s Ethernet                              |
| Monitor                    | 19" or larger recommended, capable of 1280 x 1024 resolution, 24-bit color, or better |
|                            | The monitor must provide a brightness of 200 cd/m² for rooms with < 100 lux |
|                            | The monitor must provide a brightness of 300 cd/m² for rooms with < 1000 lux |
|                            | The monitor must provide a minimum contrast ratio of 100:1 |
| Internet browser           | Recent version of Google Chrome or Mozilla Firefox  |
### 1.4.2 Minimum system requirements for DTX Studio Core (database)

<table>
<thead>
<tr>
<th>Operating system (OS)</th>
<th>Windows 7 Professional/Ultimate/Enterprise SP1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Windows 8.1 Pro/Enterprise</td>
</tr>
<tr>
<td></td>
<td>- Windows 10 Pro/Enterprise*</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 R2</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2012</td>
</tr>
<tr>
<td></td>
<td>- Windows 10 Pro/Enterprise*</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>- Windows 10 Pro/Enterprise*</td>
</tr>
<tr>
<td>Memory (RAM)</td>
<td>At least 16 GB</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel Core i3, or better</td>
</tr>
<tr>
<td>Monitor</td>
<td>No special requirements</td>
</tr>
<tr>
<td>DVD-ROM</td>
<td>DVD-ROM</td>
</tr>
<tr>
<td>Hard disk</td>
<td>8 GB free space</td>
</tr>
<tr>
<td>Pan / ceph images</td>
<td>4 GB /1000 panorama or cephalometric images</td>
</tr>
<tr>
<td>EXPRESS™</td>
<td>2 GB/1000 images</td>
</tr>
<tr>
<td>SNAPSHOT™</td>
<td>Standard resolution mode:</td>
</tr>
<tr>
<td></td>
<td>1.3 GB/1000 images</td>
</tr>
<tr>
<td></td>
<td>High resolution mode:</td>
</tr>
<tr>
<td></td>
<td>4 GB/1000 images</td>
</tr>
<tr>
<td>OP300</td>
<td>100 GB/1000 CB3D study</td>
</tr>
</tbody>
</table>

Anti-virus software and firewall are recommended to protect the system from viruses.

USB port for SNAPSHOT™

See the device manuals.
1.5 The software specifications

<table>
<thead>
<tr>
<th>APPLICATION SOFTWARE:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PRODUCT NAME</strong></td>
</tr>
<tr>
<td>Image acquisition modalities</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Image storage</td>
</tr>
<tr>
<td>Password security</td>
</tr>
<tr>
<td>Imaging procedures (pan/ceph):</td>
</tr>
<tr>
<td>---------------------------------</td>
</tr>
</tbody>
</table>
| Imaging procedures (intraoral): | Series Mount exposure  
|                                 | Single exposure                         |
| Imaging procedures (3D):        | See the corresponding device User manual |

**Image processing**

- Brightness & Contrast
- Zoom
- Move
- Noise Reduction
- Edge enhancement
- Embossment
- Invert
- Mirror
- Rotate
- Sharpen
- Unsharp mask
- Pseudocolor
- Isodensity color
- Optimize contrast (low, med, high)
- Gamma correction adjustments
- Equalized histogram
- Logarithmic histogram
- Linear histogram

**NOTICE!** Pseudocolor feature is unavailable in this version.

**NOTICE!** CB3D 3D images require 3rd party viewing and/or planning software.

| Overlay graphics | Text, Line, Free hand, Angle,  
|                  | Rectangle, Circle, Arrow,  
|                  | Region of Interest tools,  
|                  | Implant tools,  
|                  | Drag or Erase graphics,  
|                  | Edit graphics, Save graphics |

**NOTICE!** CB3D 3D images require 3rd party viewing and/or planning software.
| Measurements          | Length  
|                      | Calibration  
|                      | Angle  
|                      | Free Angle  
| **NOTICE!** CB3D 3D images require 3rd party viewing and/or planning software. |
| Image Printing (2D modalities only) | MS Windows compatible printers  
|                      | DICOM Printers  
|                      | (CLINIVIEW DICOM)  
|                      | Multi-image printing  
|                      | Free print layout design  
|                      | Image information printing  
| Image dynamics/ grayscales | 12-bit/4096 (capture)  
|                      | 16-bit/64k (process & handling)  
|                      | 8-bit/256 (display)  
| Image storage mode    | 16-bit  
| Typical file size     | Intraoral SNAPSHOT: 3-5 MB  
|                      | Intraoral EXPRESS: 0.3-2 MB  
|                      | Panoramic: 2-4 MB  
|                      | Cephalometric: 3-5 MB  
|                      | CB3D: 60 MB - 1.2 GB  
| Import/Export file formats | BMP, D32, PNG, JPG, TIF, DICOM, JPG2000, MNG  

# 1.6 The software DICOM SOP Classes

<table>
<thead>
<tr>
<th>SOP Class Name</th>
<th>SOP Class UID</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Verification</strong></td>
<td></td>
</tr>
<tr>
<td>Verification Service Class</td>
<td>1.2.840.10008.1.1</td>
</tr>
<tr>
<td><strong>DICOMDIR</strong></td>
<td></td>
</tr>
<tr>
<td>Basic Directory</td>
<td>1.2.840.10008.1.3.10</td>
</tr>
<tr>
<td><strong>Storage SCU</strong></td>
<td></td>
</tr>
<tr>
<td>Digital X-ray Image Storage for Presentation</td>
<td>1.2.840.10008.5.1.4.1.1.1.1.1</td>
</tr>
<tr>
<td>Digital X-ray Image Storage for Processing</td>
<td>1.2.840.10008.5.1.4.1.1.1.1.1</td>
</tr>
<tr>
<td>Digital Intra-oral X-ray Image Storage for Presentation</td>
<td>1.2.840.10008.5.1.4.1.1.1.3</td>
</tr>
<tr>
<td>Digital Intra-oral X-ray Image Storage for Processing</td>
<td>1.2.840.10008.5.1.4.1.1.1.3.1</td>
</tr>
<tr>
<td>VL Photographic Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.77.1.4</td>
</tr>
<tr>
<td>CT Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.1.2</td>
</tr>
<tr>
<td>Enhanced CT Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.2.1</td>
</tr>
<tr>
<td>Computed Radiography Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.1</td>
</tr>
<tr>
<td>Secondary Capture Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.7</td>
</tr>
<tr>
<td>Multi-frame Grayscale Byte Secondary Capture Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.7.2</td>
</tr>
<tr>
<td>Multi-frame Grayscale Word Secondary Capture Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.7.3</td>
</tr>
<tr>
<td>Multi-frame True Color Secondary Capture Image Storage</td>
<td>1.2.840.10008.5.1.4.1.1.1.7.4</td>
</tr>
<tr>
<td><strong>Storage Commitment SCP</strong></td>
<td></td>
</tr>
<tr>
<td>Storage Commitment Push Model</td>
<td>1.2.840.10008.1.20.1</td>
</tr>
<tr>
<td><strong>Query/Retrieve SCU</strong></td>
<td></td>
</tr>
<tr>
<td>Patient Root Find</td>
<td>1.2.840.10008.5.1.4.1.1.2.1.1</td>
</tr>
<tr>
<td>Patient Root Move</td>
<td>1.2.840.10008.5.1.4.1.1.2.1.2</td>
</tr>
<tr>
<td>Study Root Find</td>
<td>1.2.840.10008.5.1.4.1.1.2.2.1</td>
</tr>
<tr>
<td>Study Root Move</td>
<td>1.2.840.10008.5.1.4.1.2.2.2</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>Modality worklist SCU</strong></td>
<td></td>
</tr>
<tr>
<td>Modality Worklist</td>
<td>1.2.840.10008.5.1.4.31</td>
</tr>
<tr>
<td><strong>DICOM Print SCU</strong></td>
<td></td>
</tr>
<tr>
<td>Printer SOP Class</td>
<td>1.2.840.10008.5.1.1.1.16</td>
</tr>
<tr>
<td>Basic Grayscale Print Management</td>
<td>1.2.840.10008.5.1.1.9</td>
</tr>
<tr>
<td>Basic Film Session</td>
<td>1.2.840.10008.5.1.1.1</td>
</tr>
<tr>
<td>Basic Film Box</td>
<td>1.2.840.10008.5.1.1.2</td>
</tr>
<tr>
<td>Basic Grayscale Image Box</td>
<td>1.2.840.10008.5.1.1.4</td>
</tr>
<tr>
<td>Basic Color Print Management</td>
<td>1.2.840.10008.5.1.1.1.18</td>
</tr>
<tr>
<td>Basic Color Image Box</td>
<td>1.2.840.10008.5.1.1.4.1</td>
</tr>
</tbody>
</table>
# 1.7 The software compatibility table

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CRANEX 3D / 3Dx</td>
<td></td>
<td></td>
<td>x</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>CRANEX D</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CRANEX Novus / Novus e</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>DIGORA Optime</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>DIGORA Toto</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>EXPRESS</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>EXPRESS Origo</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>KaVo DIAGNOcam</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>KaVo OP 2D</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>KaVo OP 3D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>KaVo OP 3D Pro</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>KaVo Pan eXam</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>KaVo Pan eXam Plus</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>KaVo Scan eXam</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>KaVo Scan eXam One</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>OP200 D / OC200 D</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>OP30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>OP300 / OP300 Maxio</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>SCANORA 3D / 3Dx</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>SNAPSHOT</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

OPD/OCD and CRANEX D image capturing requires PCI-driver version 2.3.4.7830 or later, which is included on the installation media. For more information, see chapter 4.3 PCI driver installation.

**NOTICE!** Refer to chapter 1.4 System requirements for details about service packs.
2 Software installation

Software installation requires at a minimum a **database** for patient and image data, **client software** for image capturing, processing and viewing, at least one imaging device (imaging plate reader, intra-oral sensor or extra-oral x-ray unit) and **license server**. These software components can be installed in one workstation (standalone) or separate workstations (network installation) depending on the system needed.

**Standalone**

In a standalone system all software components are installed in the same workstation connected to the imaging device.

See chapter 2.1 *Standalone*, to install a standalone system.

**Small Network**

A small network system has one modality workstation connected to at least one imaging device for image capturing and viewing stations for image viewing and diagnosis. In a small network system the modality workstation also acts as a database server, storing all image data in the DTX Studio Core database and providing access to the image data for viewing workstations. If network licenses are used, the license server is typically installed in the modality workstation.

**NOTICE!** If network licenses are used, the license server computer must be running at all times to provide licenses to other workstations in the network.
See chapter 2.2.1 *Small network server*, to install a small network system.

**Network**

In larger network environments such as imaging centers, large dental clinics or hospitals, the software components can be installed in multiple workstations with a dedicated server. The DTX Studio Core database is typically installed in a dedicated server with a server operating system. A network installation has multiple modality workstations connected to several imaging devices for image capturing and may also have multiple dedicated viewing stations for image viewing and diagnosis. If network licenses are used, the license server is installed at the server.

**NOTICE!** The license server computer must be running at all times to provide licenses to other workstations in the network.
Installation options

There are three installation options available: Quick, Network and Advanced.

**Quick Install** is recommended to be used when all of the software components are needed in the same workstation. Installation contains DTX Studio Core, CLINIVIEW client, Licensing Server and Server Discovery components. All of the components are installed in default locations on the Windows drive. Data location can not be modified after the installation.

After the software installation, this workstation can be used as a standalone modality workstation, or as a modality workstation and a server computer for a small network.

**NOTICE!** Quick installation does not include DICOM features. These can be installed later as Add-ons.

**Network Client** is an easy option to install software clients in a network environment. This option installs the software to its default location. This option includes software for...
image capturing, processing and viewing (software client), imaging device drivers and Server Discovery components.

**NOTICE!** Network installation does not include DICOM features. These can be installed later as Add-ons.

**Advanced** option allows a more customized software installation. Advanced should be selected when preselected features in Quick and Network Client installations are not adequate.

Quick and Network Client install options are configured to cover most typical installation scenarios. Together with the Advanced option it is possible to configure the installation for any installation environment.

**NOTICE!** Software installation may require you to restart your computer to complete the installation. Save all open documents and close all running programs prior to starting installation.

**NOTICE!** Do not install any of the software components to external hard disks.

**NOTICE!** Installation creates the required Firewall settings automatically when image database components or License Server are installed.

**NOTICE!** Make sure that there are no pending or ongoing Windows updates when starting software installation.

**Display settings for the software**

The Windows display settings may have to be changed if the display is difficult to read after the software installation. The display settings can be changed in the Windows Control Panel.

The minimum Windows display settings are:

- Desktop area at least 1280 x 1024 pixels
- The monitor must provide a brightness of 200 cd/m² for rooms with < 100 lux.
- The monitor must provide a brightness of 300 cd/m² for rooms with < 1000 lux
- The monitor must provide a minimum contrast ratio of 100:1
- Color quality/Colors: Highest (32 bit)
2.1 Standalone

**NOTICE!** Before starting the installation, ensure that the PC meets the requirements listed in chapter 1.4 System requirements.

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard does not appear after a few moments, browse to the software DVD and double-click **CLINIVIEWSetup.exe** to begin installation.

   If the User Account Control window appears, you must allow changes to continue installation.

   **NOTICE!** In Windows 7, the .NET Framework 4.5 will be automatically installed if needed. Follow any on-screen prompts to continue the installation. A reboot may be required.

3. Select **CLINIVIEW Quick Install**.
4. Review the license agreements and click Yes to accept the license terms and continue with the installation.

5. Review the installation settings and click Next to start installation process. The software installation will take several minutes depending on the computer.

**NOTICE!** Licensing Server will always be installed when using Quick installation.
6. Wait until installation is completed and click **Finish** to view the software release info (Readme) and open the CLINIVIEW Server (DTX Studio Core Manager) configuration tool.

![Finish button image](image.png)

7. Upon clicking **Finish**, DTX Studio Core Manager configuration tool opens. If it does not open automatically, double click the Core Manager icon on the desktop.

8. Enter the practice name and create the administrator user account. All fields are mandatory to be filled.

**NOTICE!** Save the Administrator user account information in a safe place. If the Administrator account information is lost or forgotten it cannot be recovered and you will not be able to access Core Manager.

**NOTICE!** Do not use accented/special characters in practice name.

![Create an Account form](image.png)
9. Click **Create My Account**. DTX Studio Core Manager saves the account information.

10. Upon clicking Create My Account, the dashboard opens.

![Dashboard](image)

**NOTICE!** It is recommended to create a user account for each user. This can be done after installation in Core Manager/Configuration/Users.

11. Logout and close web browser.

12. Start CLINIVIEW. Select default language for the software and click **OK** to continue.

**NOTICE!** Software language can be changed at any time within the software from the Tools menu, Languages sub-menu.

13. To activate the license, select Activate Workstation license. See Chapter 3.2 Licensing CLINIVIEW standalone.

14. After the license has been activated successfully, the Server discovery window opens.
15. Select Server from the list, choose the connection method and click **OK**.

![Select server from list or enter server address](image)

**NOTICE!** To comply with security and regulatory guidelines that may apply to protected healthcare information (PHI), do not check the boxes to remember the Username and Password.

16. Fill in Username and Password and click Login to continue.

![Login](image)
17. After successful login, the Add Device Wizard will be displayed. Select the devices to be connected to this workstation. Please refer to the device installation manual for details of installation and configuration of each device. Click **Finish** when all devices to be connected to this workstation have been added.

18. Software is ready for use and a patient named Calibration Patient is created and opened. This patient may be used to store all calibration images for the installed device(s).

19. Test the installation by acquiring an image according to device user manual or quick guide.

20. Configure the desired user settings for the software. See User manual General Settings chapter for details.
2.2 Small network

These instructions are used to install a small network server that can be used for image viewing plus one or more viewing workstations. The following software components will be installed to the server:

- DTX Studio Core database
- CLINIVIEW client software
- License Server for managing network license keys

If you are installing the software to a network with a dedicated server, please see section 2.3, Network system.

2.2.1 Small network server

**NOTICE!** Before starting the installation, ensure that the PC meets the requirements listed in chapter 1.4 System requirements.

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard does not appear after a few moments, browse to the software DVD and double-click `CLINIVIEWSetup.exe` to begin installation.

   If the User Account Control window appears, you must allow changes to continue installation.

   **NOTICE!** In Windows 7, the .NET Framework 4.5 will be automatically installed if needed. Please follow any on-screen prompts to continue the installation. A reboot may be required.

3. Select **CLINIVIEW Quick Install**.
4. Review the license agreements and click **Yes** to accept the license terms and continue with the installation.

5. Review the installation settings and click **Next** to start installation process. The software installation will take several minutes depending on the computer.

**NOTICE!** License Server will always be installed when using Quick installation.
6. Wait until installation is completed and click **Finish** to view the software release info (Readme) and open the CLINIVIEW Server (DTX Studio Core) configuration tool.

7. After clicking **Finish**, DTX Studio Core Manager configuration tool opens. If it does not open automatically, double click the Core Manager icon on the desktop.

8. Enter the practice name and create the administrator user account. All fields are mandatory to be filled.

   **NOTICE!** Save the Administrator user account information in a safe place. If the Administrator account information is lost or forgotten it cannot be recovered and you will not be able to access Core Manager.

   **NOTICE!** Do not use accented/special characters in practice name.
9. Click **Create My Account**. DTX Studio Core Manager saves the account information.

10. Dashboard opens.

![Dashboard](image)

**NOTICE!** It is recommended to create user account for each user. This can be done after installation in Core Manager/Configuration/Users.

11. Logout and close web browser.

12. Start CLINIVIEW. Select default language for the software and click **OK** to continue.

**NOTICE!** Software language can be changed at any time within the software from the Tools menu, Languages sub-menu.

13. To activate the license, select Activate Workstation license. See Chapter 3.2 **Licensing CLINIVIEW standalone**.

14. After the license has been activated successfully, the Server discovery window opens.
15. Select Server from the list, choose the connection method and click **OK**.

16. Fill in Username and Password and click **Login** to continue.

**NOTICE!** To comply with security and regulatory guidelines that may apply to protected healthcare information (PHI), do not check the boxes to remember the Username and Password.
17. After successful login, the Add Device Wizard will be displayed. Select the devices to be connected to this workstation. Please refer to the device installation manual for details of installation and configuration of each device. Click **Finish** when all devices to be connected to this workstation have been added.

18. Software is ready for use and a patient named *Calibration Patient* is created and opened. This patient may be used to store all calibration images for the installed device(s).

19. Test installation by acquiring an image according to device user manual or quick guide.

20. Configure the desired user settings for the software. See User manual General Settings chapter for details.

21. Start License Server manager and activate the floating network license. See chapter 3.2.4.1 **Activating CLINIVIEW network license**.
2.2.2 Small network viewing workstation

**NOTICE!** Before starting the installation, ensure that the PC meets the requirements listed in chapter 1.4 System requirements.

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard does not appear after a few moments, browse to the software DVD and double-click `CLINIVIEWSetup.exe` to begin installation.

   If the User Account Control window appears, you must allow changes to continue installation.

   **NOTICE!** In Windows 7, the .NET Framework 4.5 will be automatically installed if needed. Please follow any on-screen prompts to continue the installation.

3. Select **CLINIVIEW Network Client**.
4. Review the license agreements and click **Yes** to accept the license terms and continue with the installation.

5. Review the installation settings and click **Next** to start installation process.
6. Wait until installation is completed and click **Finish** to view the software release info (Readme) and start the software.

7. Select software default language. Click **OK** to continue.

   NOTICE! **Software language can be changed at any time within the software from the Tools menu, Languages sub-menu.**

8. To activate the license select **Use Network license**. See Chapter 3.2.4.2 Configuring workstations to use CLINIVIEW network license.
9. After licensing the client, CLINIVIEW Server discovery window opens. Select server from the list, choose the connection method and click **OK**.

![Server discovery window]

10. Fill in Username and Password and click **Login** to continue.

![Login window]

**NOTICE!** To comply with security and regulatory guidelines that may apply to protected healthcare information (PHI), do not check the boxes to remember the Username and Password.
11. The Add Device Wizard will be displayed. If this workstation is only used for viewing images, you do not need to select any devices, just click **Cancel** to continue.

If you want to use this viewing station also for image capturing, select the devices to be connected to this workstation.

12. Software is ready for use. A patient named **Calibration Patient** will be created and opened. This patient can be used to store all calibration images for the installed device(s).

13. Test the installation by opening a test image captured on a modality workstation.

14. Configure the desired user settings for the software. See User manual General Settings chapter for details.

15. If the software will be used with a 3D device, install a 3D viewer software. Launch options for the 3D viewer software can be configured on the Tools menu, Image viewer Settings.

16. Repeat network client installation for each viewing workstation.
2.3 Network system

These instructions are used to install a dedicated network server that is not used for image viewing plus one or more viewing workstations. The following software components will be installed to the server:

- DTX Studio Core database
- License Server for managing network license keys

If you are installing the software to a small network without a dedicated server, please see section 2.2, Small network.

2.3.1 DTX Studio Core installation

**NOTICE! Before starting the installation, ensure that the PC meets the requirements listed in chapter 1.4 System requirements.**

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard does not appear after a few moments, browse to the software DVD and double-click **CLINIVIEWSetup.exe** to begin installation.

   If the User Account Control window appears, you must allow changes to continue installation.

   **NOTICE! In Windows 7, the .NET Framework 4.5 will be automatically installed if needed. Please follow any on-screen prompts to continue the installation.**

3. Select **CLINIVIEW Advanced** installation.
4. Select **Install CLINIVIEW Server**, this option installs DTX Studio Core database.

5. Select data storage locations. This setting cannot be modified after the installation. Click **Next** to continue.

**NOTICE!** Database data folder location is fixed and cannot be changed in this release.
6. Select *Yes, I want to install License Server*. Click *Next* to continue.

7. Select *No, I do not want to install CLINIVIEW software*. Click *Next* to continue.
8. Review the license agreement and click **Yes** to accept the license terms and continue with the installation.

9. Review the installation settings and click **Next** to start installation process.
10. Wait until installation is completed and click **Finish** to view the software release info (Readme) and open the DTX Studio Core Manager configuration tool.

11. Enter the practice name and create the administrator user account. All fields are mandatory to be filled.

   **NOTICE!** Save the Administrator user account information in a safe place. If the Administrator account information is lost or forgotten it cannot be recovered and you will not be able to access Core Manager.

   **NOTICE!** Do not use accented/special characters in practice name.

12. Click **Create My Account**. DTX Studio Core Manager saves the account information.
13. Upon clicking *Create My Account*, the dashboard opens.

14. Logout and close web browser.

15. Start the License Manager and activate network licenses. See Chapter 3.2.4 *Licensing CLINIVIEW network* for more information.
2.3.2 Network modality workstation

**NOTICE!** Before starting the installation, ensure that the PC meets the requirements listed in chapter 1.4 System requirements.

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard does not appear after a few moments, browse to the software DVD and double-click **CLINIVIEWSetup.exe** to begin installation.

   If the User Account Control window appears, you must allow changes to continue installation.

3. Select **CLINIVIEW Network Client**.
4. Review the license agreements and click **Yes** to accept the license terms and continue with the installation.

5. Review installation settings and click **Next** to start installation process.
6. Wait until installation is completed and click **Finish** to view the software release info (Read-me) and start the software.

7. Select software default language. Click **OK** to continue.

**NOTICE!** Software language can be changed at any time within the software from the **Tools menu, Languages**.

8. To activate the license, select **Use Network license**. See Chapter 3.2.4.2 Configuring workstations to use CLINIVIEW network license.
9. After licensing the client, CLINIVIEW Server discovery window opens. Select server from the list, choose the connection method and click **OK**.

   ![Server discovery window](image)

10. Fill in Username and Password and click **Login** to continue.

   ![Login screen](image)

**NOTICE!** To comply with security and regulatory guidelines that may apply to protected healthcare information (PHI), do not check the boxes to remember the Username and Password.
11. After successful user login, the Add Device Wizard will be displayed. If this workstation is only used for viewing images, you do not need to select any devices, just click **Cancel** to continue.

If you want to use this viewing station also for image capturing, add the devices to be connected to this workstation.

12. Software is ready for use. A patient named *Calibration Patient* will be created and opened. This patient may be used to store all calibration images for the installed device(s).

13. Test the installation by opening a test image captured on a modality workstation.

14. Configure the desired user settings for the software. See User manual General Settings chapter for details.

15. If the software will be used with a 3D device, install a 3D viewer software. Launch options for the 3D viewer software can be configured on the Tools menu, Image Viewer Settings.

16. Repeat network client installation for each viewing workstation.
2.3.3 Standalone License Server

In specific cases, you may need to install a standalone License Server to a workstation or server. Installing a standalone License Server is not supported by the Installshield Wizard provided with the software. If you need to install a standalone License Server, please follow these steps.

1. Insert software DVD into DVD-ROM drive.

2. If the InstallShield Wizard appears, click Cancel.

3. Browse the install DVD media from My Computer and open the \ISSetupPrerequisites folder.

4. Double-click the file IDLSsetup.exe to start the License Manager installer.
   
   If the User Account Control window appears, you must allow changes to continue installation.

5. Follow the on-screen instructions to install the License Manager.

6. See chapter 3, Licensing CLINIVIEW software for instructions how to use the License Manager.
2 Software installation
3 Licensing CLINIVIEW software

3.1 Important licensing information

IMPORTANT! License activation keys are printed on a label attached to the installation DVD media cover or provided electronically by email. Keep your license activation keys in a safe place! License activation keys are required if you need to reinstall the software. Lost license activation keys will not be replaced. If you did not receive license activation keys together with this software please contact your distributor immediately.

CLINIVIEW software can be used for a trial period of up to 30 days after installation. When the trial period has expired CLINIVIEW software must be licensed.

To activate the CLINIVIEW license you must use the activation key (an alphanumeric code) that is printed on a sticker attached to the CLINIVIEW software CD case. Save the activation key in a safe place.

The CLINIVIEW license activation requires an Internet connection.

If the computer in which CLINIVIEW software is to be installed is not connected to the Internet, select the offline activation method and use any computer that is connected to the Internet to activate the license.

If the license activation cannot be completed after installing CLINIVIEW software, activate the trial period by selecting Start Trial Now from License Activation Wizard which is shown when starting CLINIVIEW software. CLINIVIEW software can now be used for up to 30 days. The offline license activation process can now be completed later at a different location where you have access to the Internet.

Note that the license activation response file that you will receive must be sent back to the site where CLINIVIEW software was installed to complete the offline license activation process.

In case capturing workstation also acts as Database workstation and is installed with Licensing server and database sharing, activate the standalone CLINIVIEW license first and then the CLINIVIEW network license. Note that the standalone license and network license are installed using separate License Manager tools, see chapter 3.2.5, License Manager for more information.
When the CLINIVIEW network license has been activated, additional viewing workstations can be configured to use the network license, see chapter 3.2.4, Licensing CLINIVIEW network, how to activate a network license and how to configure workstations to use the network license.

### 3.2 Licensing CLINIVIEW standalone

#### 3.2.1 Online connection

The computer is connected to the Internet.

1. When the CLINIVIEW software is opened for the first time a license activation request window appears.

   Select **Activate workstation (node-locked) license**.
3. Licensing CLINIVIEW software

2. The **Select activation method** window appears.

   Select **Online activation** and then press **Next**.

   ![Select activation method](image)

3. The **Registration** page appears.

   Enter all the registration information. It is important to enter the license owner contact information correctly.

   Mandatory fields are marked with an asterisk (*)

   When you have entered all the required information into the Registration page, click **OK**.

   ![Registration](image)
4. The **Online activation** window appears. Enter the software activation key, that is printed on the sticker attached to the CLINIVIEW software CD case, into the **Enter activation key** field.

Click **Activate**.

CLINIVIEW software connects to the license server to activate the license.

5. Press **Next** when the license has been successfully activated. The following window asks to submit feedback on the products which were purchased and installed. Press **Register now** to give feedback and to launch CLINIVIEW software. Pressing **No thanks** launches CLINIVIEW software.
3.2.2 Offline connection

The computer is not connected to the Internet.

1. When the CLINIVIEW software is opened for the first time a license activation request appears.

   Select **Activate workstation (node-locked) license**.

2. The **Select activation method** window appears.

   Select **Offline activation** and then press **Next**.
3. The **Offline activation** request window opens. Select **Generate request**.

An offline activation request must first be generated and then sent to Instrumentarium Dental.

Click **Next**.

4. The **Registration** page appears.
Enter all the registration information. It is important to enter the license owner contact information correctly. Mandatory fields are marked with an asterisk (*).
When you have entered all the required information into the Registration page, click **OK**.
5. The **Offline activation** window appears. Enter the software activation key, which is printed on a sticker attached to the CLINIVIEW CD case, into the appropriate field.

   Click **Next**.

6. The **Save request** window appears.

   Select the location where you wish to save the activation request file and the help file, for example the Windows Desktop.

   Click **Next**.
7. The Request succeed window appears. Click **Show in folder** to locate the request file (the file ends with “.xml”). Copy the request file and place it into any computer that is connected to the Internet. You can also copy the help file (same name as the request file but ends with “.txt”) if you wish to refer to the instructions during the activation process.

![Request succeeded window]

8. Now using the computer connected to the Internet send the request file as email attachment to licensing@instrumental.com and wait for a response. The typical response time is between 5 and 20 minutes.

9. When you receive a response email from Instrumentarium Dental, copy the file attached to the email and save it in the computer where CLINIVIEW software was installed (the response file ends with .lic).

10. In the **Request succeeded** window click **Process response**.

![Offline activation window]

**NOTICE! If you are unable to wait for the response from Instrumentarium Dental, press Finish to close the window.**

You can continue the activation process later by clicking **Process response** in the **Offline activation request window.**
If you are unable to complete the offline activation process in the time available you can activate the CLINIVIEW 30 day trial period so that CLINIVIEW software can be used temporarily.

11. The **Select response** window appears. Select the activation request response file from the folder where it was saved.

   ![Offline activation window]

   Click **Next**.

   A message appears confirming that CLINIVIEW software is now licensed.
3.2.3 Trial period activation

1. In the license activation request window click **Start trial now**.

   ![License Activation Wizard](image)

   Click **Finish**.

   CLINIVIEW software can now be used for a maximum of 30 days. When the trial license is activated it will automatically expire after 30 days. When the CLINIVIEW license is activated it does not cancel the trial license. If trial license expires and a proper license has not been activated, CLINIVIEW software cannot be started.

   **NOTICE!** When CLINIVIEW software is used in the 30 day trial mode, the **Continue using trial** window will appear each time CLINIVIEW software is started. Click **Continue trial** to continue the trial period and use the software.

3.2.4 Licensing CLINIVIEW network

3.2.4.1 Activating CLINIVIEW network license

Open License Manager tool in the computer, where the Licensing Server has been installed. To open License Manager, select Start ⇒ INSTRUMENTARIUM DENTAL ⇒ License Server ⇒ License Manager.

Activate the Network License using the License Manager tool. See chapter 3.2.5, **License Manager**.
NOTICE! The License Manager tool is delivered with both CLINIVIEW and License Server. You recognize the correct License Manager tool from the large red text “LICENSE SERVER” on the tool window.

3.2.4.2 Configuring workstations to use CLINIVIEW network license

Configure CLINIVIEW workstations to use network license by selecting the option “Use network license” from License activation wizard. Enter the Licensing server hostname or IP address to the next screen.
Local license server address can be configured also from workstation License Manager tool. To configure local license server address using License Manager click \textbf{Settings} and enter the local license server address.
### 3.2.5 License Manager

The License Manager tool lists all licenses active in the computer and allows the licenses to be managed.

Local License Manager can be opened from CLINIVIEW Tools menu.

![License Manager](image)

**Activate license** button

Starts the license activation process, see chapter 3.2.1, Online connection and 3.2.2, Offline connection.

**Return license** button

CLINIVIEW license can be active only in one computer at a time. Any license which has been activated through the INSTRUMENTARIUM DENTAL™ license server can be returned to the INSTRUMENTARIUM DENTAL license server.
This is needed when you need to transfer the license to a different computer (for example if the computer is being replaced). Note that trial licenses cannot be returned to INSTRUMENTARIUM DENTAL license server.

Select the license you wish to return from the list and click **Return**.

The return operation can be done using online or offline methods.

Select **Online return** if the computer is connected to the Internet.

**Offline return** generates a request file and processes a response file the same way as in Offline connection.

After successful return operation you can then activate the license in another computer.

**Repair license** button

If the license Status is BROKEN, for example the program has been corrupted, select the license, click **Repair** and then select online or offline repair depending on whether the computer is connected to the Internet or not.

**Settings** button

Allows you to select the language of the license manager.

Also shows the license server addresses. These should not be modified unless instructed to do so.
License users

**NOTICE!** This feature is only available in License Server version of the License Manager.

Double clicking a network license opens license usage window. The license usage window shows in the topmost list all software features which are available in the selected network license. Selecting a feature from the topmost list shows all activated network licenses which include the selected feature in the "Licenses with selected feature" list. The list in the bottom of the window titled "Users of selected feature" shows the computer names where the selected feature is currently in use. The "Total license count" is the sum of all licenses which include the selected feature.
3 Licensing CLINIVIEW software
4 Driver installation

Compatible drivers and firmware must be installed before starting to use the device with the software.

**NOTICE!** Contact your distributor to check latest device drivers required by different product configurations.

4.1 Device drivers

Device drivers are installed during software installation for all devices supported by the software. Drivers can be upgraded using INSTRUMENTARIUM DENTAL Driver Updater. See readme.txt in the updater installation media for installation instructions.

4.2 NVIDIA drivers

Validated NVIDIA drivers required for 3D image reconstruction are located on the software installation media in \Drivers\NVIDIA. See readme.txt for installation and upgrade instructions.

4.3 PCI driver installation

**NOTICE!** Before installing a PCI driver, the PCI board must be installed to the PC.

1. Right-click My Computer and select Manage. Click on Device Manager.
2. Go to **Other devices** node and expand it.

3. Right click on PCI Device and then click on **Update Driver Software...**
4. Select the option **Browse my computer for driver software**.

5. Browse for PCI driver from the software DVD. Click **Next**.
6. Select the check-box **Always trust software from PaloDEx Group Oy** and press **Install**.

![Windows Security]

7. Wait for the installation to complete.

![Installing driver software...]

8. Press **Close** when the installation of the PCI driver is over.

![Windows has successfully updated your driver software]

![Close button]
4.3.1 PCI driver update

The PCI driver version must be 2.3.4. If an older PCI driver is installed, it must be upgraded.

1. Right-click My Computer and choose Manage. Click on Device Manager.

2. Go to PaloDEx Group Imaging devices node and expand it.
3. Right-click on **PCI Device** and then click on **Update Driver Software**.

4. Select the option **Browse my computer for driver software**.
5. Browse for the folder having PCI driver from the software DVD. Click Next.

6. Wait for the installation to complete.
7. Press **Close** when the update of the PCI driver is over.
4.3.2 Uninstalling the PCI driver

If the driver installation fails, remove the driver and then reinstall it.

1. Right-click My Computer and choose Manage. Click on Device Manager.

2. Go to PaloDEx Group Imaging devices node and expand it.
3. Right click on PCI Device and then click on Uninstall.

4. Select the check-box Delete the driver software from this device and Click OK.

4.4 Intraoral camera installation

The software supports image capturing with WDM (Windows Driver Model) and VFW (Video For Windows). WDM is recommended for the software.

Install the video capture card and the drivers supplied with your intraoral camera, following the intraoral camera’s installation instructions.

To enable intraoral camera capture select IntraCam in Tools ⇒ Settings ⇒ Intraoral camera tab. Click Settings to open the settings dialog.

To hide intraoral camera capture button, clear the checkbox in Tools ⇒ Settings ⇒ Intraoral camera tab.
To achieve the best possible image quality, it is recommended that the camera device is checked. Click **Settings** to open the settings dialog.

Normally the device is selected automatically.

Use ‘Close after image snap’ slide bar to specify how many seconds a capture image stays top of the screen after capturing.

Use ‘Capture Delay’ to prevent camera shake caused by button press. It is the delay between IntraCam’s button click and actual image capture. Set the value in the Delay editbox of IntraCam’s settings dialog.

Use ‘Shortcuts’ to configure shortcut keys to start capture session, snap image and end capture session. The default values for the same are -

- Start capture F4
- Snap image F5
- End capture F6

**NOTICE!** The software supports Dürr Dental’s PC-COM port connectable 3-button foot pedal.
4.4.1 Video Format dialogs

Click **Format** to open the window.

Select the used Video Standard on Video Decoder tab. These alternatives vary according to camera manufacturer and country.

Adjust e.g. the brightness, contrast, hue and saturation. These alternatives vary according to camera manufacturer.
4.4.2 Video Source dialog

Open the Video source dialog by clicking Source.

Select the requested dimensions for the camera window from the Output Size list.

Select the requested color setting from the Color Space list. It is recommended to use 24-bit RGB. These alternatives vary according to camera manufacturer and country.

4.4.3 Video Input dialog

Click Input to open the window.

Select the used input video connector from the Input list, S-video is recommended.
4.4.4 Link the software to Intra camera event

If Intra Camera supports events, link the software to the Intra camera event, e.g. "Button Pressed" event. When the Intra camera's button is pressed, the software retrieves an image automatically.

1. Open Scanners and camera properties in the Control Panel. Select your Intra Camera from the devices list and click Properties.

2. Select Events Tab.
3. Select "New Picture Requested" from the Camera Events list and Enable CLINIVIEW option from the lower list.

4. Change the Camera event to "Button Pressed" and Enable CLINIVIEW option.

5. Before the configuration is valid reboot your PC.

NOTICE! If the Events tab is not displayed, then this feature is not available for the selected Intra Camera.

4.5 KaVo DIAGNOcam

NOTICE! DIAGNOcam is only available outside the US.

The driver for KaVo DIAGNOcam is included on the installation media but is not installed by default. To install the driver after the software has been installed, please follow these instructions:

1. Close the software if it is open.

2. Go to Windows Settings / System / Apps & features (Windows 10 or 8.1) or Control Panel / Programs and Features (Windows 7).

3. Locate CLINIVIEW in the installed programs list and select it.

4. Click the Modify button and wait until the setup window appears.
5. Click the Advanced Modify button and select DIAGNOCam by placing a check mark in the box, then click Next.

6. If the Windows Security message appears, click the Install button to continue.

7. The driver will be installed. Click the Finish button when the driver installation is complete.

A button for DIAGNOCam will be added to the image capturing toolbar. Refer to User manual chapter 3.4 KaVo DIAGNOCam for more information.
5 Configuring DICOM

Before using the software DICOM features the DICOM option must have been installed and the system should be configured. Refer to chapter 9.5, Adding options using Add-ons.

**NOTICE!** The software DICOM is a licensed feature. A DICOM license key must have been given in either during the software client installation or in the software Manager application, after the installation.

**NOTICE!** The Windows language must be the same used for patient names in the software, otherwise there may be patient name character encoding issues in images that are sent via DICOM storage.

To perform the software DICOM configuration, you need the following information (this information is normally provided by the local network administrator):

- Network configuration information for the software workstation
- Port numbers for DICOM configurations
- IP addresses
- AE titles for the software entities
- AE titles, Port numbers and IP addresses for the needed DICOM devices
  - Storage server
  - Storage Commitment
  - Printer
  - Worklist
  - Query/retrieve

The IP addresses, port numbers and AE titles for all connections can be obtained from the hospital's ADP personnel & suppliers.

**NOTICE!** Elevated (administrator) user rights are required to access DICOM configuration settings. To start the application with elevated user rights, right-click the application icon on the desktop or Start menu and select "run as administrator". If the current user account does not have administrator rights you will be prompted to enter a user name and password with administrator rights.
The DICOM configuration window

The tabbed pages

The DICOM configuration window includes a tabbed set-up/property page for each of the features selected when the DICOM addition was installed. If all four features were selected, there are six tabbed set-up/property pages. These are:

- General
- Print
- Query/Retrieve
- SOP Classes
- Storage
- Worklist
- Storage SCP

The main configuration buttons

After making configuration changes, click **Apply** or **OK** at the bottom of the DICOM configuration window to accept the changes.

- **Apply button**
  Click to save changes. The DICOM configuration remains open.
- **Cancel button**
  Changes are not saved and the DICOM configuration closes.
- **OK button**
  Click to save changes. The DICOM configuration closes.
5.1 General page

The General page gives an overview of the Local DICOM parameters.

The "Local Application Entity Title" is the DICOM name for the software. The name must be 1 to 16 characters in length (letters A-Z and/or numbers 0-9) with no spaces.

Contact the (hospital) administrator to obtain the correct “Application Entity Title” (AE-title)

5.1.1 DICOM License number

The DICOM license key is managed through the license key of the software. The license key of the software is entered either during the software client installation or in the software Manager after the installation.

5.1.2 Retired Command Elements

Controls are provided to select how the software uses the command elements that have been retired from the DICOM standard 3.0. It is recommended to leave these controls empty.
5.2 SOP Class configuration

The software allows to configure which SOP Class is used to correspond the image types of the software.

Panoramic images:
- Digital X-Ray Image For Processing (PX) (default)
- Digital X-Ray Image For Presentation (PX)
- Digital X-Ray Image For Processing (DX)
- Digital X-Ray Image For Presentation (DX)
- Computed Radiography Image Storage

Cephalometric images:
- Digital X-Ray Image For Processing (DX) (default)
- Digital X-Ray Image For Presentation (DX)
- Computed Radiography Image Storage

Intra images:
- Digital X-Ray Image For Processing (DX) (default)
- Digital X-Ray Image For Presentation (DX)
- Digital Intra-oral X-Ray Image Storage
  - For Processing
- Digital Intra-oral X-Ray Image Storage
  - For Presentation

Photographic images:
- VL Photographic Image Storage (default)
- Secondary Capture Image Storage
- Multi-frame Grayscale Byte Secondary Capture Image Storage
- Multi-frame Grayscale Word Secondary Capture Image Storage
- Multi-frame Truecolor Secondary Capture Image Storage

CB3D
- Enhanced CT Image Storage (default)
- CT Image Storage

CB3D scout
- Digital X-Ray Image For Processing (DX) (default)
- Digital X-Ray Image For Presentation (DX)
- Computed Radiography Image Storage

(Single-) VT Projection images
- Digital X-Ray Image For Processing (DX) (default)
- Digital X-Ray Image For Presentation (DX)
- Computed Radiography Image Storage

(Single-) VT Reconstruction images
- Digital X-Ray Image For Processing (DX) (default)
- Digital X-Ray Image For Presentation (DX)
- CB3D Image Storage
- Computed Radiography Image Storage
5.3 Worklist configuration

The DICOM Modality Worklist Server allows information about patients to be obtained from the Hospital Information System. The software supports the Modality Worklist Service as a Service Class User. The Modality Worklist Service Class Provider is a program which purpose is to provide information to the Modality Worklist Service Class User. Worklist Page allows a connection to the Modality Worklist Service Class Provider (SCP) to be configured.

5.3.1 WorkList SCP Box

**AE Title**
This option specifies the Application Entity Title for the SCP application.

The AE Title is a characters string with a maximum length of 16 characters. The AE Title is a DICOM name for a DICOM Modality Worklist Service Class Provider (SCP) which can receive DICOM queries from the software.

**Host Name**
Is the remote host name or its IP-Address. For example: 10.1.1.0.
5 Configuring DICOM

Port
Is the TCP port on which the remote DICOM system listens for connections. The default DICOM port number is 104. Obtain from the (hospital) administrator.

Polling interval (sec)
Specifies the polling interval in seconds, the software makes queries to the Modality Worklist SCP.

If 0 seconds is set here, no polling is done. The user has to update the contents of the worklist dialog with the Refresh button when needed. This setting is not available in the Search from worklist SCP mode.

Refresh Timeout
This value specifies the timeout, that the application waits for the worklist service to finish the refreshing. The value is given as seconds.

Search method
If Refresh from worklist SCP mode is selected, the manual refreshing of the worklist, cause the worklist query (C-FIND) to be sent to the Worklist SCP. This is the recommended option for cases, where the C-FIND operations are fast or the user wants full control of the refreshing.

If Refresh from local database mode is selected, the manual refreshing does not send a Worklist query, but only reads the latest data from the local worklist database. This local database has the results of the worklist polling done on the background. Note: make sure the polling is enabled. This is the recommended option for cases, where the C-FIND operations take a relatively long time.

If Search from worklist SCP mode is selected, the Worklist SCP is searched directly for worklist items using only the filters provided in the worklist search dialog. There is no automatic polling, but the C-Find query is sent only when the user initiates the search. This mode is potentially the slowest, but provides the most control for the user.

The Verify Button
See the Storage Page in this manual for more information.

5.3.2 Search for worklist items by date

Set the number of day(s) before and after today that are taken into account in worklist search. Using values 0 and 0
here, means that only worklist items scheduled for today are queried from the worklist server. This setting is not available in the Search from worklist SCP mode.

5.3.3 Modalities Box

Checking the modality boxes allows the chosen modalities to be retrieved from the Modality Worklist SCP.

<table>
<thead>
<tr>
<th>Modality</th>
<th>SOP Class Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>DX</td>
<td>Digital Radiography</td>
</tr>
<tr>
<td>IO</td>
<td>Intraoral Radiography</td>
</tr>
<tr>
<td>PX</td>
<td>Panoramic X-Ray</td>
</tr>
<tr>
<td>CR</td>
<td>Computed Radiography</td>
</tr>
<tr>
<td>XC</td>
<td>External camera Photography</td>
</tr>
<tr>
<td>CT</td>
<td>Computed Tomography</td>
</tr>
<tr>
<td>Other</td>
<td>User-defined modality:</td>
</tr>
<tr>
<td></td>
<td>can be left empty, in which case</td>
</tr>
<tr>
<td></td>
<td>modality is not used as a search</td>
</tr>
<tr>
<td></td>
<td>criteria.</td>
</tr>
<tr>
<td></td>
<td>Also several modalities can be</td>
</tr>
<tr>
<td></td>
<td>defined (separated by a space).</td>
</tr>
</tbody>
</table>

(This setting is not available in the Search from worklist SCP mode.)
5.3.4 Scheduled Station

This option can be used to retrieve only the items scheduled for the specified workstation (AE Title). This setting is not available in the Search from worklist SCP mode.

5.3.5 Worklist Page buttons

Columns button

Define the attributes and the order in which they appear in the Worklist window in the “Set Columns” dialog. Click Columns and the “Set Columns” window opens. The Set Columns window is divided into two lists:

1. Hidden Attributes List.
2. Shown Attributes List.

![Columns button screen capture]

The "Shown Attributes" list includes the attributes that appear in the software Worklist window. The attributes in the hidden attributes list does not appear in the window.

To move the attributes from one list to another:

- Click on the attribute to move (the attribute changes color). Click the arrow to move the attribute in the direction required.

  or

- Click on the attribute to activate it. Without releasing the mouse button, drag the attribute to the other list or within the list to change the place of the attribute, then release the mouse button (drag and drop).
NOTICE! All the changes made in the 'Columns' window remains temporary after clicking OK. To save the changes permanently, click OK or Apply in the DICOM Worklist configuration tab.

Colors button

Click Colors and the “Set Colors” window appears. To change a status color, click the appropriate arrow button beside each color.

A “Color selection” window appears.

Select a basic or custom color for the required status and click OK.

NOTICE! All the changes made in the 'Color' window remains temporary after clicking OK. To save the changes permanently click OK or Apply in the DICOM Worklist configuration tab.

Advanced button

The "Log Files" and "Performance" pages provide parameters for adjusting the low level settings of the DICOM network services. There are similar settings for all the DICOM network services. See chapter 5.8, Log File and Performance Settings.
5.3.6 Other options

Hide following worklist items

Choose the option that suits best.

<table>
<thead>
<tr>
<th>Option</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Items are not hidden</td>
</tr>
<tr>
<td>Older than current date</td>
<td>All items older than current date are hidden</td>
</tr>
<tr>
<td>Stored (older than current date)</td>
<td>All items that are stored and older than current date are hidden</td>
</tr>
</tbody>
</table>

Copy Scheduled Procedure Step Description to Study Description

If this option is selected then Scheduled Procedure Step Description is copied automatically to the Study Description tag.

Copy Requested Procedure Description to Study Description

If this option is selected then Requested Procedure Description is copied automatically to the Study Description tag.

Study date/time

This setting controls how the Study Date and Study Time tags of a new study are filled, when the study is created from a worklist item, that lacks the Study Date and Study Time values.
5.4 Storage and Storage Commitment configuration

The Storage page allows the storage and storage commitment parameters to be defined. When this page is opened for the first time after installation, two empty lists appear.

-The Storage Destination List (upper).

-The Storage Attributes List (lower).

The Storage Destination List (upper).
Add storage servers to the storage server destination list, e.g. DICOM ARCHIVES.

The Storage Attributes (Tag) List (lower).
Add and edit DICOM Tag information to the tag list.
5.4.1 Storage page - Destinations

Storage page - Add new... button

Allows a new destination for the images to be added. Click Add new and the “Add New Destination” window appears.

Fill in the fields as follows:

1. Destination: Section describing a remote DICOM application. Client refers to the destination by a DICOM Application Entity Title (AE Title) and this is the same way it is referred to in the application profile. A destination name can be, for example, DICOMArchive.

2. AE Title: The AE Title is a string of 16 characters or less with no spaces, for example, STORAGE_SCP.

   NOTICE! The AE Title string is case sensitive.

3. IP Address: a remote host name or its IP address, for example, 10.0.0.2.

4. Port: a TCP port which the remote DICOM system listens to. The default DICOM port number is 104. Obtain from the (hospital) administrator.

5. If Storage Commitment -feature is used, define the Storage Commitment SCP settings: either choose the "Use the same destination for Storage Commitment" - option or define the Storage Commitment SCP AE Title, IP address and TCP port explicitly.

   NOTICE! Port number must not be greater than 65535.

When defined the storage destination, click OK. The storage page appears with the new destination in the upper list and the attributes in the lower list.

This indicates that you have successfully added a new destination to the storage application.

Repeat the above steps each time to add a new destination.
Storage page - Delete button

Allows a destination to be deleted from the destination list. To do this:

1. Select the destination to be deleted, the line is highlighted.
2. Click Delete.
3. A delete confirmation message appears. Click Yes to delete the destination.

Storage page - Edit... button

Allows the destination information in the storage destination list to be changed. To do this:

4. Select the destination to be edited, the line is highlighted.
5. Click Edit.
6. The Edit Destination window appears.
7. Edit the destination information.

8. Click OK to accept the changes. The destination information in the storage window is updated.

Storage page - Advanced... button

The "Log Files" and "Performance" pages provide parameters for adjusting the low level settings of the DICOM network services. There are similar settings for all the DICOM network services. See chapter 5.8, Log File and Performance Settings.

In addition to the settings common to all services, there are following Storage SCU specific settings:

Retry count
The number of retry attempts to make if the storing of an image has failed. Use 0 to disable the retrying.

**Retry interval**

The time period, in minutes, that is waited between the retries.

**Storage page -Set as Default button**

Allows the default destination to be set if there are more than two destination places in the Destination List. Select the destination entry to be set as the default. Click Default to set this destination as the default.

**Storage page -Verify button DICOM Verification**

All communications and image transfer with the remote application are accomplished using the DICOM protocol over a network using the TCP/IP protocol stack.

Verify application level communication between DICOM application entities (AE’s), click Verify. If there are no selected items (highlight) in the destination list, the Edit, Delete, Set as Default, and Verify buttons are disabled. Select the destination item to be verified. All buttons are enabled. Click Verify.

The DICOM Verification window gives information on the state of communication between the destination and computer. If communication is successful, a verification window appears showing all the parameters.

The 'DICOM parameters' are from the destination. The 'Network Parameters' are parameters that provide information about the status of the communication with that
remote entity. If communication fails, the 'Network status' is Failure, and the 'Association status' explains the cause of the failure, for example "Failed to connect to remote host". NA appears in both the Remote Implementation Class UID and Remote Implementation version and the list of services is empty.

The results of the communication between entities can be printed or saved.

To save select *File > Save as...* or click **Save**.

To print select *File > Print* or click **Print**.

### 5.4.2 Storage page -Attributes List buttons

If the focus of the window is in one of the destinations in the storage destination list, only **Add New** is enabled. Once the focus (the line is selected) is put into one of the attributes in the storage attributes list, the rest of buttons are enabled.

The Attributes list includes default attributes for the DICOM application. Add and edit the attributes or delete them from the list.
Attributes list - Add new... button

To add a new attribute to the storage attribute list, click Add New. The “Add New Tag” window appears:

A message is constructed from attributes having values, and each attribute is identified by a tag. An attribute is a unit of data (e.g., Patient's Name, Patient 10, ...). A tag is a 4-byte number identifying an attribute (e.g., 00100010H for Patient's Name, ...).

A tag is usually written as an ordered pair of two-byte numbers. The first two bytes are sometimes called a group number, and the last two bytes are called an element number (e.g., (0010,0010), (0038, 001C),...). This terminology is partly a remnant of the DICOM Standard.

DICOM specifies Information Object Definitions (IOD's) as being composed of modules. Each module contains attributes. Attributes can be required, optional, or only required under certain conditions (conditional attributes). Conditional attributes are always specified along with a condition.

Storage list - Edit... button

To change information of one of the destinations' attributes that is already in the storage attributes list, perform the following steps:

1. Select the attribute to be changed (the line is selected).
2. Click Edit. The Modify Tag window appears.
3. Enter the new information and click OK. The changes appear in the storage attributes list.

Storage list - Delete Button

Allows an attribute to be deleted from the storage attributes list. To do this:
1. Select the attribute to be deleted (the line is selected).
2. Click **Delete**.
3. A delete confirmation message appears.
   Click OK to delete the attribute.

### 5.4.3 Storage Commitment settings

The Storage Commitment feature can be enabled or disabled with the check box control.

When enabled, both the storing of images and requesting commitment for the images use the software Storage SCU Application Entity. The details of this AE must be configured: AE Title and Port number. Contact the local system administrator to get these values.

**NOTICE!** Do not use the same AE Title and port number as in Storage SCP.

#### Storage Commitment - Advanced

**Maximum retry count for failed Commitment attempts**

This parameter defines the number of retries to be made if the Storage Commitment attempt fails for some reason. Use 0 to disable the retry feature.

**Retry interval for failed commitment attempts**

This parameter defines the wait time period between the retries. Minutes are used.

**Wait for commitment report in N-ACTION Association**

Some Storage Commitment SCPs are able to send the Storage Commitment report within the same association as the Storage Commitment request. This attribute defines the time period, in seconds, that the software Storage Commitment SCU waits for the report message. Use 0 to always require separate association to be used for the Storage Commitment report.
Wait time for storage commitment report

The time period, in minutes, that Storage Commitment SCU waits for Storage Commitment report after requesting it. After this time period expires, the status of the Storage Commitment task goes either into Waiting for Storage Commitment Retry, if the retrying is enabled and there are retries left, or to Storage Commitment Failed. Reports can still be received, and they are processed, even after this timeout has expired.

Delay between storage and commitment

The time period that Storage Commitment SCU waits after Storage before sending the Storage Commitment request.

5.5 Print configuration

Open this page for the first time after installation and see two empty lists.

1. The Print Destination List.
2. The Print Attributes List.

Print Destination List.
To the Print Destination List add DICOM printers.

Print Attributes (Tag) List
To the Print Tag List add settings for every DICOM printer, e.g. media size.
5.5.1 Print page - Destinations

Print page - Add new... button

Add a new DICOM printer by clicking Add new.

Complete the fields as follow:

1. Printer name:
   Application refers to the printer by a DICOM Application Entity Title (AE Title) and this is the same way it is referred to in the application profile. In this field, enter a name for AE Title, for example DICOM_PRINTER.

2. AE Title:
   Obtain from the (hospital) administrator, for example PRINT_SCP.

3. IP address:
   Obtain from the (hospital) administrator, for example 10.0.0.3.

4. Port:
   The TCP port on which the remote DICOM system listens for connections. The default DICOM port number is 104. Obtain from the (hospital) administrator.

5. Capabilities:
   If the DICOM printer supports grayscale OR color printing, select
   - Basic Grayscale Print Management
   - Basic Color Print Management
If the printer supports both printing modes, select either or both modes. Refer to the operating manual supplied with the DICOM printer for more information.

Click OK after entering all the required information.

A print page appears, which indicates that a new printer has been successfully added to the list.

The top list shows the configuration information that has been entered. The bottom list shows all the printer's attributes and their characteristics (Tag number, Name, Module, Type and default value).

Repeat the above procedure each time to add a DICOM printer.

**Print page - Edit... button**

Change the information in the printer list.

1. Select the printer to be edited.
2. Click Edit.
3. The Edit Printer Properties window appears.

Enter new printer information.

1. Click OK to accept the changes. The destination information in the printer destination window is updated.

**Print page - Delete button**

Delete a printer from the print list.

1. Select the printer to be deleted.
2. Click Delete.
3. A delete confirmation message appears. Click Yes to delete the printer.

**Print page - Advanced... button**

The "Log Files" and "Performance" pages provide parameters for adjusting the low level settings of the DICOM network services. There are similar settings for all
the DICOM network services. See chapter 5.8, Log File and Performance Settings.

**Print page - Verify button**
Verify DICOM printer connection.

### 5.5.2 Print page - Attributes List buttons

With the attribute list buttons you can edit the printer default settings.

**Edit... button**
Select the attribute in the list, which is needed to be changed (the line turns blue)
Click **Edit**.

![Image of Edit Tag Properties dialog box](image)

Check the correct default values from the printer documentation or (hospital) administrator. Enter new information and click **OK**. The changes appear in the Print Attributes list.

**Delete button:**
Delete an attribute from the print attributes list.

1. Select the attribute to be deleted.
2. Click **Delete**.
3. A delete confirmation message appears.
4. Click **Yes** to delete the print attribute.

### 5.6 Query / Retrieve configuration

The Query / Retrieve service provides a tool for search and retrieve of patients and images from image archives.
Query / Retrieve page:

Complete the fields as follow:

**AE Title:**
Obtain from the (hospital) administrator, for example QR_SCP.

**IP address:**
Obtain from the (hospital) administrator, for example 10.0.0.2.

**Port:**
The TCP port on which the remote DICOM system listens for connections. The default DICOM port number is 104. Obtain from the (hospital) administrator.

**Verify button**
See the Verify button in the previous chapters of this manual for more information.

**Application Entity Title for Move Service**
Specify the AE Title of the target Application Entity, i.e. the AE where the retrieved images are sent. Typically, this is the local Storage SCP AE.

**Query Model**
Select either Patient Root or Study Root.
Failed Retrieve Retry Count
This is the limit for the retry attempts that would made after retrieving is failed. 0 means that not retries are done if the initial retrieve attempt.

Retry interval
This is the time interval in minutes, that will be waited between the retries.

The Advanced Button
See or make any changes to the patient/image search, click Advanced. The Advanced window appears.

![Advanced Window](image)

The Advanced window shows default patient search criteria, normally these can be left empty.
5.6.1 Query options

Editing default Query / Retrieve messages

From the module and level scroll boxes choose different types of query levels.

In these boxes the following information can be found:

<table>
<thead>
<tr>
<th>Module</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Root</td>
<td>- Patient</td>
</tr>
<tr>
<td></td>
<td>- Study</td>
</tr>
<tr>
<td></td>
<td>- Series</td>
</tr>
<tr>
<td></td>
<td>- Image</td>
</tr>
<tr>
<td>Study Root</td>
<td>- Study</td>
</tr>
<tr>
<td></td>
<td>- Series</td>
</tr>
<tr>
<td></td>
<td>- Image</td>
</tr>
</tbody>
</table>

Add, Edit and Remove buttons

Click Add to increase the items in one of the lists (request or response).

The following dialog appears which allows relevant information to be entered into the fields.

Remember that a Tag is usually written as an ordered pair of two-byte numbers. The first two bytes are sometimes called a ‘group’ number, with the last two bytes being
called an ‘element’ number (e.g., (0010, 0010), or (0038, 001C)).

The VR or Value Representation can be thought of as the ‘type specifier’ for the values that can be assigned to an attribute. This includes the data type, as well as its format.

The Value is the variable to which the value stored in the attribute is assigned.

To change or remove one of the list items, first select the item in the list and then click the corresponding button.

The edit or remove dialog appears with the fields containing the data of the item to be changed or removed.

After the changes, click OK to accept them.

To remove an item, the following confirmation message appears.
Up and Down buttons

These buttons are located in the bottom left-hand corner of the advanced dialog in the C-Find Response group box. They can only be used with that list.

With the Up and Down buttons change the order of the list items. Select the item to move up or down the list and then click UP/DOWN.

5.6.2 The Log Files and Performance pages

The "Log Files" and "Performance" pages provide parameters for adjusting the low level settings of the DICOM network services. There are similar settings for all the DICOM network services. See chapter 5.8, Log File and Performance Settings.

5.7 Storage SCP

Storage SCP page

The Storage SCP page allows the storage parameters to be defined. The service is used when a remote DICOM application sends the images to the software. The software works as Storage Service Class Provider (SCP) to the remote system.

Define the software storage service application entity title and TCP port number on the Storage SCP page.

NOTICE! Do not use the same AE Title and Port numbers for Storage SCP and Storage SCU (in chapter 4.4.3)
services. Also port number must not be greater than 65535.

Click **OK** or **Apply** to save the configuration parameters.

**Temp File Folder**

The folder on the local hard drive, where the retrieved images are saved temporarily before saving them to database, can be configured here.

**Storage SCP page - Advanced button**

The "Log Files" and "Performance" pages provide parameters for adjusting the low level settings of the DICOM network services. There are similar settings for all the DICOM network services. See chapter 5.8, Log File and Performance Settings.

### 5.8 Log File and Performance Settings

The **Log File Page** allows the configuration, the database, the error log file or the storage service log file destinations and parameters to be changed.

- **Configuration Database field:**
  Allows the database name (Data Source Name)
and location (Filename) to be changed. Key in the specified path directly or click **Browse** and select the required name and location.

- **Write ODBC:**
  When the ODBC check box is selected, a new DSN entry is to be inserted into the system DSN list. Refer to ODBC and Microsoft Windows documentation for details.

- **Error Log File field:**
  Allows the errors log file name and its maximum size in bytes to be selected.

- **Storage Service Log File field:**
  Allows the Storage Service message log file to be selected and configured. The log file name, maximum size, the line length, and log message levels are configurable.

```
<table>
<thead>
<tr>
<th>Log Files</th>
<th>Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Log File</td>
<td></td>
</tr>
<tr>
<td>Filename</td>
<td>C:\Documents and Settings\ Users\ A</td>
</tr>
<tr>
<td>Maximum size (lines)</td>
<td>500</td>
</tr>
</tbody>
</table>

| Activity Log File |             |
| Filename | C:\Documents and Settings\ Users\ A | Browse ... |
| Maximum size | 1000 |

| Message Log File |             |
| Filename | C:\Documents and Settings\ Users\ A | Browse ... |
| Maximum size (lines) | 100000 |
| Log Message Levels |         |
| Error level | | |
| Warning level | | |
| Info level | | |
```

The Log message levels are as follows:

- **Error level:**
  This level logs error messages. These messages mainly occur when the network fails, or when reading in or writing DICOM messages.

- **Warning level:**
  This level logs warning messages.

- **Info level:**
  This level logs informational messages.

- **T1 level:** not used
- **T2 level:**
This level logs the entire contents of messages sent or received over the network.

- **T3 level:**
  This level logs information related to association negotiation.

- **T4 level:**
  This level logs information when incoming associations are being rejected.

- **T5 level:**
  This level logs information when a message is validated.

- **T6 level:**
  This level logs the contents of the Merge tool kit configuration.

- **T7 level:**
  This level logs the contents of the command elements (group 0) for received and sent messages.

- **T8 level:**
  This level logs warning messages related to streaming in or out messages and files.

- **T9 level:**
  This level logs information about PDUs sent or received.

- **Blank fill log file:**
  If this feature is selected the log file size is to be expanded to the maximum possible size.

- **Backup old log files:**
  If this feature is selected old log files are backed up.

- **Historical log files:**
  To select the number of historical log files saved.
The Performance Page allows various parameters to be changed to improve performance.

**PDU max. length:**
Maximum size of Protocol Data Units that can be sent or received by the software DICOM.

**Timeouts box:**
Allows various timeouts (in seconds) to be set. If the application is running in a multi-tasking environment, the process is blocked during this waiting period and the system processor is available for other processes. If all the timeouts are set to 0 this is equivalent to polling, as DICOM returns immediately, whether a message has been received or not.

- **Association Request:**
  The waiting time for association request or for the peer to shut down an association.

- **Association Response:**
  The waiting time for a reply to an associate request.

- **Connection:**
  The waiting time for a network connection to be accepted.

- **Release:**
  The waiting time for a reply to an associate release.

- **Write:**
  The waiting time for a network write to be accepted.
5 Configuring DICOM

- Inactivity:
The waiting time for data between TCP/IP packets

Buffers:
This box allows various buffers to be configured to improve performance.

- Work Buffer:
  This option sets the buffer size before DICOM application stores the data or passes it. Setting higher values for this option increases performance.

- Send Buffer:
  This option sets the TCP/IP send buffer size. Higher values for this buffer increases the network performance of the tool kit for client (SCU) applications. This value is larger than the PDU max length.

5.9 Glossary

ACR:
American College of Radiology; Initiated the DICOM standardization effort in the early 80's

ACR-NEMA:
Predecessor of the DICOM standard defined by the ACR and NEMA; two versions were defined 1.0 and 2.0

AE:
Application Entity; a software process which implements DICOM. Most implementations use multiple AE’s when implementing multiple Service Classes.

Attribute:
Attributes are the components of an information object definition (100), describing its properties.

DICOM:
Digital Imaging and Communications in Medicine standard.

IOD:
Information Object Definitions.

MergeCOM-3:
Merge Technologies Inc. provided toolkit performing low-level DICOM communication.
**Modality:**
Acquisition system such as a CT, MR, US, NM, CR.

**NEMA:**
National Electrical Manufacturing Association.

**PDU:**
Protocol Data Unit, a packet that is created at the DICOM lower-level protocol.

**SCP:**
Service Class Provider

**SCU:**
Service Class user

**SOP:**
Service Object Pair

**TCP/IP:**

**UID:**
Unique Identifier.
6 DTX Studio Core

6.1 Changing the database location

**NOTICE!** If content of local database needs to be moved, see chapter 7.1 How to restore a database to another installation or new location.

6.1.1 Server Discovery

Server Discovery starts automatically when CLINIVIEW software is started for the first time.

After the installation Server Discovery can be started from CLINIVIEW Tools menu, or from Windows Start menu/CLINIVIEW Server Discovery.

Changing server connection

1. Open Server Discovery.

2. a) Select the server, the suitable connection method and click OK.
   b) Type the connection details in the text box.
   For example:
   http://computername:33000
   http://192.168.0.123:33000

   or for secured connection

   https://computername:34000
   https://192.168.0.123:34000
3. Click **OK** and Restart CLINIVIEW software.

While CLINIVIEW is not running Server Discovery can be started from Windows 7 Start menu or from Windows 8 Start screen.

### 6.2 Database backup and restore

**NOTICE!** *Be sure to backup all data, which includes the database snapshot and image data. The following folder must be backed up on a regular basis:*

C:\ProgramData\CliniView Server\data

By default, DTX Studio Core creates automatically snapshots each night 02:00.

#### 6.2.1 Making instant backup from the DTX Studio Core database

**NOTICE!** *The folder paths given below are the default locations for a new installation. If the software has been upgraded from 11.0 or 11.1, the paths may be different. Verify the paths in case an upgrade has been done to ensure you are backing up the correct folders.*

How to create snapshot now:

1. Start DTX Studio Core Manager (Core Manager icon on the desktop)
2. Login to DTX Studio Core Manager, using administrator account
3. Open Configuration
4. Open Snapshot
5. Click Snapshot Now
6. Database snapshot is created in folder C:\ProgramData\CliniView Server\data\snapshots
7. Make a backup of the data folder C:\ProgramData\CliniView Server\data
8. Mark the backup media with the current date and store it in safe place.

**NOTICE!** *The server computer must be running during the backup time. If the server computer is shut down, backups will not be made.*
6.2.2 Restoring the DTX Studio Core database from a backup

**CAUTION!** Database snapshots (backups) can only be restored to the same version of DTX Studio Core that created the snapshot. Do not attempt to restore snapshots created by a different version of DTX Studio Core.

How to restore snapshot:

1. Start DTX Studio Core Manager (Core Manager icon on the desktop)
2. Login to DTX Studio Core Manager, using administrator account
3. Open Configuration
4. Open Snapshot
5. Click Snapshot file
6. Click Restore
7. DTX Studio Core Manager prompts for restore confirmation Click OK
8. After few minutes system reports Database restore is completed and asks for DTX Studio Core restart.
9. Open Services in Windows Control Panel and Restart the DTX Studio Core service
7 Restoring DTX Studio Core database to a new installation and/or location

**NOTICE!** This procedure must be used whenever DTX Studio Core has been re-installed.

**CAUTION!** Database snapshots (backups) can only be restored to the same version of DTX Studio Core that created the snapshot. Do not attempt to restore snapshots created by a different version of DTX Studio Core.

7.1 How to restore a database to another installation or new location

If you already have an up-to-date backup of the whole data folder (data), and you have a matching db-snapshot file in the snapshots folder, you can skip step 1.

1. Make a snapshot from the existing database (source) by creating a current database snapshot file in DTX Studio Core Manager.

2. Make a backup of the database snapshot folder (e.g. “C:\ProgramData\CliniView Server\data\snapshots”), INCLUDE ALL CONTENTS!
3. Install the DTX Studio Core database to the new computer (destination). Select the proper image data location in installation options.

4. Modify the desired data folder location, if needed.

5. Replace the new, empty data with the backup.

6. Select the correct snapshot file with 'Restore from snapshot file' and click Restore.

7. Answer OK, restore database.

8. Click Restore, and then OK.

9. Restart the DTX Studio Core after the restore is completed.
8 Upgrading the software

A few features from older versions of the software are not supported in this release. It is not recommended to upgrade the software if the following features are still actively used in an older version of the software:

- Volumetric Tomography (VT)
- OP100D/OC100D devices
- Image archives created using CLINIVIEW Manager
- Access to deleted images in the Trash in CLINIVIEW Manager

**NOTICE!** Install a supported browser before starting the upgrade. Supported browsers are listed in the software requirements.

**NOTICE!** Check CLINIVIEW system requirements before starting upgrade and the requirements for any devices that will be connected to the software.

**NOTICE!** Archived and deleted images in the Trash from an older version of the software will not be accessible in the new software after database migration. If you need access to these images, restore them prior to upgrading the software.

**CAUTION!** Before you start the upgrade, back up the database and images.

**CAUTION!** Image archives created using an older version of the software cannot be restored to this version of the software. If access to image archives is needed, the archives must be restored prior to upgrading the software using CLINIVIEW Manager.

**NOTICE!** Upgrading will create Windows Firewall settings automatically.

**NOTICE!** Software upgrades may require new license activation keys depending on the version currently installed. Do not start the upgrade unless you have new license activation keys or have verified that the current activation keys are valid for this version of the software. If the software is upgraded and activation keys are not available, you will not be able to access the software or images created by an older version. After each workstation has been upgraded, enter the license activation key(s)
provided with the new software using License Manager. Refer to 3, Licensing CLINIVIEW software for more details.

This release supports upgrading from CLINIVIEW 10.x and CLINIVIEW 11.x only.

**WARNING!** Do not attempt to upgrade older versions of the software. Only the versions listed above can be upgraded using this software release.

**CAUTION!** After upgrading from an older version, image default settings may have changed. New acquired images may appear different compared to the previous version.

**CAUTION!** After upgrading from an older version, existing images may appear different due to changes in image filters compared to previous version.

**CAUTION!** Image archives created using an older version of the software cannot be restored to this version of the software.

### 8.1 Upgrading to CLINIVIEW 11.4

1. Insert software DVD into DVD-ROM drive.
2. If the installation wizard does not appear after a few moments, browse to the installation media and double-click CLINIVIEWSetup.exe to begin installation.

   **NOTICE!** If the User Account Control window appears, you must allow changes to continue installation.

3. The installation wizard will automatically start in Upgrade mode.

   **NOTICE!** You may be prompted to install additional requirements if they are not installed on your computer. Install these requirements and the installation will continue automatically.
4. Click **Next** to continue.

5. The installation wizard will display a reminder to backup the database. If the backup has been done, click **Yes** to continue with the upgrade.

6. When upgrading from version 10.x, the installation wizard will ask you to select a location for the image data folder for DTX Studio Core. Select a suitable data folder and click **Next**. This selection will not be shown when upgrading from version 11.x.

7. Review the License Agreements and click **Yes** to agree and continue.
8. Review the current settings. In addition to upgrading previously installed components, this upgrade will automatically install Server discovery and Migration components when upgrading from version 10.x. Click **Next** to continue.

![Software upgrade installation](image)

9. The software upgrade installation will start. Installation will take some time, please wait.

10. When the installation wizard is complete, click **Finish** to end the installation. A computer restart may be required. Restart the computer if indicated before continuing.

![Installation complete](image)

11. The DTX Studio Core Manager configuration tool will open automatically. If it does not appear, double-click the Core Manager icon on the desktop.

12. Enter a Practice Name and click **Next**.

   **NOTICE!** *Do not use special characters in the Practice name.*

13. Enter the administrator user information and create the administrator user account. All fields are mandatory.
8 Upgrading the software

NOTICE! Save the administrator user account information in a safe place. If the administrator account information is lost or forgotten it cannot be recovered and you will not be able to access DTX Studio Core Manager.

14. Click Create My Account. The administrator account is saved and the dashboard opens.

15. It is strongly recommended to create additional user accounts to be used when connecting to DTX Studio Core using CLINIVIEW clients. To create additional user accounts, click Configuration on the dashboard and then Create New Account. Enter the user account information and create the additional user accounts. All fields are mandatory. By default, additional users are automatically assigned to the User role.

NOTICE! If you are upgrading the client from version 11.1, you must restart the PC before starting the upgraded client for the first time.

8.2 Database migration

After upgrading the software from CLINIVIEW 10.x, data must be migrated from the old database to the DTX Studio Core database. Upgrading from CLINIVIEW 9.x and earlier is not supported in this release.

NOTICE! This release does not support Volumetric Tomography (VT) images. If your existing database contains VT images, migration will be aborted.
NOTICE! A supported browser must be installed to use the HTML-based database migration tools. Refer to the list of supported browsers in chapter 1.4.2 Minimum system requirements for DTX Studio Core (database).

NOTICE! The disk space on the target server needs to be checked before starting the migration. At a minimum, it is recommended that you have at least as much free disk space as the combined size of the DATA folder and database files, plus an additional 25-50% free space.

NOTICE! User accounts created in CLINIVIEW 10.x and older will not be migrated to DTX Studio Core. You can create new user accounts in DTX Studio Core Manager for each user as needed.

NOTICE! If you are upgrading an older version that was installed with EDBI, you need to manually install the migration components in the \Tools\Migration folder by running CliniViewMigrationSetup.exe on the computer where the old database is installed.

1. On the computer where the Migration Service is installed, launch Migration Server from the desktop icon or Start menu.

2. Enter the security key 778480 and click Submit.

3. The Migration Service will prompt for the username and password for the old database. Check the "Use default credentials" checkbox and leave the username and password empty unless the old database was installed using EDBI. If EDBI was used, enter a valid username and password to connect to the old database. Then click Next.
4. Migration service is now configured and the migration continues using Core Manager. You may close the browser window.

5. Launch Core Manager using the desktop icon Core Manager.

6. Login to DTX Studio Core Manager with an administrator user account.

7. Click the Configuration button.

8. Click the Migration tab, the Migration control center will open. Select the old source database from the drop-down menu on the left under Source database, then enter the DTX Studio Core administrator user account credentials on right side under Destination database. Then click Next.

9. Select a schedule when the migration should occur and then click Start migration.

**NOTICE!** Migration will use up to 100% of the available CPU resources. Schedule the migration to occur during non-working hours to avoid disruption.
10. Migration will start based on the selected schedule. The migration status can be checked by opening Migration control center from Core Manager at any time.
9 Adding features

It is possible to add features or modalities at any time after the installation.

9.1 Adding devices

**NOTICE!** This release does not support Volumetric Tomography (VT). Do not enable VT or attempt to capture images using VT with this release.

**NOTICE!** If you need to use OP300, OP300 Maxio, Pan eXam Plus, CRANEX 3D/3Dx, OP 3D or OP 3D Pro device, you must run C:\Program Files (x86)\ PaloDEx Group\IAM\test\image\processing.exe from a command prompt before these devices can be added.

1. Switch on the device(s) that you wish to connect to the PC in which CLINIVIEW software is installed.

2. Open CLINIVIEW software, click **Patient search**, select any patient and then click **Open**.

3. Select **Tools** ⇒ **Device settings**. On the device tab, click **Add** to add a new device.

4. An **Add Device** window will appear showing the device(s), switched on and connected to the PC.

![Add Device Wizard](image)

Select the device that you wish to connect and click **Finish**. Repeat for any other devices that you wish to connect.

**NOTICE!** If you cannot see the device you wish to connect in the **Add Device** window, add the device manually, see section 9.2, **Adding devices manually** for information on how to do this.
9.2 Adding devices manually

If the device you require does not appear in the Add Device Wizard window, the device can be connected to the PC manually.

1. Make sure that the device that you wish to connect to the PC is switched on.

2. On the Add Device window, click the Add manually button.

3. The Add Device manually window will appear.

![Add manually](image)

The window displays a pictorial list of all the devices that can be connected to the PC.

4. Click the picture of the device you wish to connect to select it.

Then click Next, or double click the picture of the device.

![Next button](image)

5. The IP-Address window will appear.

![IP-Address](image)
Enter the IP address and then click the Connect button. The connection to the unit will be checked. After the connection has been checked and the device connected, click Finish.

**NOTICE!** If you wish to change the IP-address of the device, click the Change device IP address... button and follow the on-screen instructions that appear.

### 9.3 Removing devices

Click Remove button in the device listing to remove a device. A message will appear asking you to confirm the removal.

### 9.4 Auto-connect

A certain device can be set to be connected to automatically during the startup of CLINIVIEW software.

On the Device tab, select the device from the list you wish to be connected automatically. Click on the check box under Auto-connect to enable automatic connecting for the selected device.
9.5 Adding options using Add-ons

You can add a new option (e.g. License Server, DICOM) at any time after the installation.

1. Start ⇒ Control Panel ⇒ Programs and Features.

2. Select CLINIVIEW. Click Change.

3. The software Setup Maintenance mode starts. Select CLINIVIEW software Add-ons and click Next.
4. See already installed add-ons features in the Add-ons dialog. Add features by selecting the needed features, e.g. DICOM. Click **Next**.

5. Select DICOM components.

**NOTICE!** If you are adding DICOM features to a previous installation using a network license (License Server), you must open the License Manager, clear the license server address and activate a DICOM workstation (node-locked) license.
6. Review the features and click **Next**.

7. System is successfully modified, a restart is recommended.
10 Uninstalling

10.1 Uninstalling the software

To uninstall the software, select Start ⇒ Control Panel ⇒ Programs and Features, select CLINIVIEW software and click **Remove**. Follow the instructions on the screen.

Or

To uninstall the software, insert software DVD. The software installation program starts its Maintenance mode. Click **Remove** to uninstall the software.

Software uninstallation leaves folders on the hard drive and saves the database and images. Uninstallation is for removing the software only.

Repeat the software uninstallation as needed for all computers (Modality workstation, viewing workstation, server) having any software components.

**CAUTION!** When software and database is uninstalled, access to images and patient data will be lost until the software is reinstalled and the data restore procedure has been completed. Please refer to chapter 6.3 for details. After restore, images and patient data will be accessible again.

**NOTICE!** If uninstallation shows a warning “Database could not be locked”, close the software from all client computers and try again. If all clients are closed and the error still occurs, restart the computer and retry uninstallation.

**NOTICE!** Only the CLINIVIEW software software is removed. Other software components that may be installed during CLINIVIEW software installation such as IAM and License Server can be uninstalled if no longer needed.
11 Recycle Bin

Patients and images (media) can be marked as deleted in the software so that they no longer appear in the software. Items are not actually removed from the database but are placed in the Recycle Bin. Items in the Recycle Bin will remain there until deleted or restored using DTX Studio Core Manager. Items in the Recycle Bin are organized by separate Patient and Media pages.

To view the contents of the Recycle Bin:

1. Launch DTX Studio Core Manager using the desktop icon Core Manager or Start menu.
2. Login to DTX Studio Core Manager with an administrator account.
3. Click the Monitoring button.
4. Click the Recycle Bin Patients or Recycle Bin Media tab.

Information is displayed in three columns:

- The Date/Time column indicates when the item was deleted.
- The Type column indicates if the item is a Patient or Media (image).
- The Patient column shows the name of the patient.

The Delete and Restore buttons allow you to perform actions on deleted items.

To restore a deleted item, click the Restore button. Restored item will be visible in the software.

To permanently delete an item, click the Delete button.

**CAUTION!** You will not be asked for confirmation when clicking the Delete button. Deleted items are permanently removed and cannot be recovered.
CAUTION! X-ray dose information for deleted images will be lost. Dose reports for these images should be created and archived before deleting images.
12 Using practice management interface

NOTICE! If patient data is transferred in to the software by other software, this software must conform to applicable local laws and regulations on patient information softwares.

12.1 Introduction

The software uses an initialization file called CLINIVIEW.ini.

The file is installed in the software settings:

- C:\ProgramData\CLINIVIEW

The software installation directory and executable path are defined in Windows registry.

HKEY_LOCAL_MACHINE\SOFTWARE\Instrumentarium Dental\CLINIVIEW

- ProgramDir- CLINIVIEW path, for example C:\Program Files\CLINIVIEW

- ExeFile- CLINIVIEW executable, for example C:\ProgramFiles\CLINIVIEW\CLINIVIEW.exe

When starting the software, the settings are read from the CLINIVIEW.ini configuration file. It is allowed to run only one instance of the software on a computer at a time. If starting the software while the software is already running, no additional instances of the program are started. However, the already running the software reads the Practice Management Interface section of the CLINIVIEW.ini file and acts accordingly. Finally, the software sets all entries in the Practice Management Interface section to 0.

The Practice Management Interface section in the CLINIVIEW.ini file is described below.

The mandatory fields are:

USE_PRACTICE_MANAGEMENT:

If set to 1, the software reads the Practice Management Interface section at startup and on activation and users are
not allowed to change or add new patients manually from the software user interface

CLEAR_PRACTICE_MANAGEMENT_AUTOMATICALLY:

If set to 1, the software resets USE_PRACTICE_MANAGEMENT and the patient keys every time the software reads the CLINIVIEW.ini file. If set to 0, the software does not reset (to 0) the keys.

PATID:

Patient ID shall be unique and defined by PMS software.

Practice Management Interface PATBD defines date of birth, which shall be formatted as defined in system regional settings.

CLEAR_PRACTICE_MANAGEMENT_AUTOMATICALLY =1 USE_PRACTICE_MANAGEMENT= 1

PATID = 00000
PATLNAME = 0
PATMNAME = 0
PATFNAME = 0
PATSOCSEC = 0
PATBD = 0
PROVIDER1 = 0
PROVIDER2 = 0
ADDRESS1 = 0
ADDRESS2 = 0
CITY = 0
STATE = 0
ZIP = 0
HOMEPHONE = 0
WORKPHONE = 0
FAX = 0

EMAIL1 = 0

EMAIL2 = 0

Some PMS software that uses previous versions of the software might require that
USE_PRACTICE_MANAGEMENT is permanently set by
the user to 1 and that
CLEAR_PRACTICE_MANAGEMENT_AUTOMATICALLY
= 0.

It is recommended that the PMS application sets both
USE_PRACTISE_MANAGEMENT=1 and
CLEAR_PRACTISE_MANAGEMENT_AUTOMATICALLY
= 1.

The software can read patient information from any ini file if
the following line is added to
[PracticeManagementInterface]- section:

BRIDGEFILE_LOCATION_OVERRIDE =C:\my_ini_file.ini.

12.2 How to use CLINIVIEW.ini

Set
CLEAR_PRACTICE_MANAGEMENT_AUTOMATICALLY
= 1, if the PMS software automatically sets
USE_PRACTICE_MANAGEMENT = 1. Otherwise, set the
key to 0.

To add a patient:

- Set USE_PRACTICE_MANAGEMENT = 1 ·
- Set PATID to a patient ID that does not exist in the
  software database yet.
- Fill in the patient data fields
- (Re)start the software

To alter patient information:

- Set USE_PRACTICE_MANAGEMENT = 1
- Set PATID to match the patient whose information
  is to be changed.
- Fill in the patient data fields to be changed.
- If the content of a specific data field is not needed
to be changed, set its value to 0.

- (Re)start the software

To preselect a patient:

- Set USE_PRACTICE_MANAGEMENT = 1
- Set PATID to match the patient to be preselected.
- Set all data fields to 0.
- (Re)start the software

To disable the practice management interface:

- Set USE_PRACTICE_MANAGEMENT = 0

12.3 VDDS Media interface

Installation and configuration

The installer for VDDS Media is included on the CLINIVIEW installation media in the \Tools\Interfaces\VDDS-Media folder. To start the installation, double-click the file CliniViewVDDSSetup.exe and follow these instructions.

**NOTICE! If the User Account Control window appears, you must allow changes to continue installation.**

1. When the Welcome screen appears, click Next to start the installation.

2. After installation is completed, ensure the checkbox “Launch VDDS Configuration when finished” is checked and click Finish.

3. The configuration window will open, enter a valid Username and password.
4. Click the OK button to complete the configuration.

**NOTICE!** The currently configured server is shown in the VDDS configuration window. To change the server, click the Change button. You can also test the connection to the currently configured server by clicking Test Connection.

**NOTICE!** To use smaller thumbnail images instead of full size images, mark the checkbox in the configuration window. Otherwise, full size images will be returned to the VDDS application.

**NOTICE!** VDDS configuration can be accessed at any time from the Start menu -> CLINIVIEW VDDS -> CLINIVIEW VDDS Configuration.

**NOTICE!** VDDS configuration is stored for each Windows user account. If multiple users login to the same PC, each user must login and run VDDS configuration once to set up VDDS for their user account.

**NOTICE!** If you use a VDDS-compliant practice management application to change patients in the software, it is recommended to disable the auto-connect feature in imaging device settings. Auto-connect will prevent changing patients via VDDS applications when a device is auto-connected.
Upgrading legacy VDDS

If you have a previous version of the VDDS Media interface installed on your workstation, it needs to be upgraded along with the new CLINIVIEW software.

1. Install and configure the CLINIVIEW 11.1 VDDS Media interface as instructed before.
2. Uninstall the legacy VDDS Media interface.
3. Re-register the new VDDS.
13 Software license

THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU, AS THE <LICENSEE>, AND PALODEX GROUP OY (THE <LICENSOR>) GOVERNING YOUR RIGHT TO USE THE CLINIVIEW SOFTWARE (<Software>).

IF YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THE SOFTWARE LICENSE AND THIS PARAGRAPH, PLEASE PRESS <I Agree> AT THE PROMPT BELOW IN WHICH CASE YOU AGREE THAT THIS AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGNED BY YOU. IF YOU DO NOT CONSENT TO THE SOFTWARE LICENSE AND THIS PARAGRAPH, PLEASE PRESS <Cancel> AT THE PROMPT BELOW, IN WHICH CASE THE SOFTWARE WILL NOT OPERATE AND RETURN THE SOFTWARE AND THE ACCOMPANYING ITEMS TO YOUR PLACE OF PURCHASE FOR A REFUND.

1. Subject-matter of the Software License

This Software License governs the use of the Software. Software means the software product specified above including new versions or updates of the Software made generally available to other licensees of such Software free of charge, if any.

2. Software License Grant

2.1 Licensor hereby grants you a non-exclusive and non-transferable license to use during the term of this Software License (i) the Software, in object code form only and in accordance with the terms of this Software License and (ii) manuals and other documentation related to the Software. You have no right to sublicense the Software and you are under the obligation to return the same to Licensor upon the expiration or termination of this Software License.

2.2 You are entitled to use each licensed Software only on a single computer or terminal at any one time and, if necessary for use on such computers or terminals, to modify the Software or merge them into another program, all portions of the program continuing to be subject to this Software License in full. Such other program must, however, conform to all applicable local laws regulations on patient imaging systems. Licensor shall not be held liable for any damages resulting directly or indirectly from a modification or merger of the Software.
made by you, even if Licensor approved such modification or merger.

2.3 You are granted no rights hereunder other than those expressly set out herein above and, consequently, all other activities related to the Software are prohibited. Such prohibited activities include but are not limited to (i) the deleting, adding to, copying, modifying or transferring the Software or any part thereof, or any copy or merged portion thereof, in whole or in part, except as expressly provided for herein or authorized in advance by Licensor in writing and (ii) the renting or leasing of the Software to another party.

3. Software License Limitations and Conditions

3.1 You hereby expressly agree that Licensor and its software suppliers own throughout the world all right, title and interest in the Software, any copies thereof and all intellectual property rights contained or embodied therein including the ownership to any modifications or translations of the Software and that such ownership or rights shall not be transferred to you.

3.2 With respect to any software of third party suppliers contained or to be contained in the Software, you agree to the ownership of Licensor's suppliers hereunder and accept that Licensor's suppliers are direct and intended third party beneficiaries of this Software License with rights solely against you, including (without limitation), on reasonable prior notice to and consent of Licensor, the right to directly enforce and/or terminate your license to use the Software. Further, you agree that Licensor's suppliers have no liability or obligations towards you arising out of or in connection with this Software License. You agree to execute any such amendments to this Software License as may be required from time to time in order to comply with terms and conditions of any third party software suppliers.

3.3 Your license to use the Software shall commence upon the execution of this Software License, and shall thereafter remain in effect unless you fail to comply with the terms and conditions of this Software License, including any amendments thereto. Upon termination by Licensor or its suppliers of this Software License, you shall, within two (2) business days thereafter, certify to Licensor that in accordance with instructions from Licensor or its suppliers, all copies of the Software have been either destroyed or returned to Licensor, whether same is in tangible or intangible form and you shall fur-
ther certify that all use thereof is and shall remain terminated.

3.4 You agree to comply with all applicable export and re-export restrictions and regulations, including the ones imposed by the government of the United States or of the country to which the Software is shipped to you. You shall not commit any act or omission, which will result in a breach of any such export requirements.

3.5 Should you receive any copy of the Software to upgrade a previous version of such Software such upgraded version of the Software shall be the only version you are entitled to use unless otherwise agreed and, unless expressly otherwise permitted by Licensor, you shall destroy or erase all program material and related documentation, including all copies and modifications, relating to the previous Software.

4. Copyright

4.1 The Software shall be delivered subject to all restrictions and protections provided for under the applicable copyright and other laws and treaties. Except as otherwise may be agreed by Licensor in writing, you have no right to reproduce or otherwise duplicate the Software or any part thereof for any purpose or to allow any third parties to do the same without the prior written consent of Licensor. Notwithstanding the above, you may make one copy of the Software for back-up purposes provided that such copy and the media thereof shall include the same copyright and other proprietary notices or legends included on the Software when it was shipped to you. You agree not to remove any Software identification, copyright notices or other notices or proprietary restrictions from the Software.

5. Confidentiality

5.1 The Software contains proprietary and confidential information of Licensor and its suppliers and is considered by Licensor and its suppliers to constitute valuable trade secrets. You agree to hold the Software in confidence and protect the Software with at least the same degree of care with which you protect your own similar confidential information but in no event less than a reasonable standard of care. You agree that your officers and employees shall protect the confidentiality of the Software and all confidential and non-public information relating thereto and shall not disclose such information to any third party. This obligation of
confidentiality shall survive the termination of the Software License.

5.2 You agree not to decompile, reverse assembles or reverse engineers the Software or otherwise attempt to derive source code from the Software. The prohibition in the foregoing sentence shall apply only to the extent permitted by applicable law. When information of the internal structure of the Software is necessary in order to obtain interoperability of the Software with other software programs, you shall immediately contact Licensor.

6. Disclaimer of Warranties

6.1 To the maximum extent permitted by applicable law, Licensor and its suppliers provide the SOFTWARE <as is> and hereby disclaim all warranties and conditions, either express, implied or statutory, including, but not limited to, any (if any) implied warranties or conditions of merchantability, of fitness for a particular purpose, compatibility, of lack of viruses, of accuracy or completeness of responses, of results, and of lack of negligence or lack of workmanlike effort, all with regard to the SOFTWARE and any part thereof, and the provision of or failure to provide support services. There is also no warranty or condition of correspondence to description or non-infringement with regard to the SOFTWARE or any part thereof. Licensee shall bear the entire risk as to the quality or compatibility of or arising out of use or performance of the SOFTWARE.

6.2 To the maximum extent permitted by applicable law, in no event shall Licensor or its suppliers be liable for any actual or special, incidental, indirect, or consequential damages whatsoever (including, but not limited to, damages for loss of profits or confidential or other information, for business interruption, for personal injury, for loss of privacy, for failure to meet any duty including of good faith or of reasonable care, for negligence, and for any other pecuniary or other loss whatsoever) arising out of or in any way related to the use of or inability to use the Software, the provision of or failure to provide support services, or otherwise under or in connection with any provision of this Software License even in the event of the fault, tort (including negligence), strict liability, breach of contract or breach of warranty of Licensor or any of its suppliers, and even if Licensor or any of its suppliers has been advised of the possibility of such damages.
7. Applicable Law and Jurisdiction

7.1 This Software License to be construed governed by and interpreted in accordance with the laws of Finland, excluding the UN Convention on Contracts for the International Sale of Goods.

7.2 Disputes arising from or in connection with this Software License are to be settled by arbitration by one arbitrator. The Board of Arbitration of the Central Chamber of Commerce of Finland shall appoint the arbitrator and the Rules of the said Board are to be followed in the arbitration proceedings. The arbitration shall be held in Helsinki, Finland and conducted in the English language.

7.3 Notwithstanding the foregoing, Licensor and its suppliers shall have the right, but not the obligation, to undertake legal proceedings in a court of your domicile, principal place of business or other appropriate court to: (i) settle any issue or dispute arising out of or relating to monies due by you to Licensor; (ii) protect or enforce any patent, trademark, copyright or other intellectual property right, confidential information or trade secrets; or (iii) proceed with litigation commenced by a third party.

7.4 Judgment upon the award rendered may be entered in any Court having jurisdiction or application may be made to such Court for a juridical acceptance of the award and an order of enforcement, as the case may be.

8. General

8.1 This Software License (together with license terms of third party suppliers of Licensor, if any) constitute the entire agreement with respect to the subject matter hereof between you and the Licensor and supersedes all previous oral or written communications or agreements relating to the same. Only a written instrument expressly agreed to by the parties hereto may modify this Software License.

8.2 The failure of Licensor to enforce any provision of this Software License shall not be considered a waiver of any subsequent breach of that provision or as a waiver of any other provision hereof.
13 Software license